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Notice

All information included in this document is current as of the date this document isissued. Such information, however, is
subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful atention to
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights
of Renesas Electronics or others.

Y ou should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of
semiconductor products and application examples. Y ou are fully responsible for the incorporation of these circuits, software,
and information in the design of your equipment. Renesas Electronics assumes no responsibility for any lossesincurred by
you or third parties arising from the use of these circuits, software, or information.

When exporting the products or technology described in this document, you should comply with the applicable export control
laws and regulations and follow the procedures required by such laws and regulations. Y ou should not use Renesas
Electronics products or the technology described in this document for any purpose relating to military applications or use by
the military, including but not limited to the devel opment of weapons of mass destruction. Renesas Electronics products and
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited
under any applicable domestic or foreign laws or regulations.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics
does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages
incurred by you resulting from errorsin or omissions from the information included herein.

Renesas Electronics products are classified according to the following three quality grades: “Standard”, “High Quality”, and
“Specific”. The recommended applications for each Renesas Electronics product depends on the product’ s quality grade, as
indicated below. Y ou must check the quality grade of each Renesas Electronics product before using it in aparticular
application. You may not use any Renesas Electronics product for any application categorized as “ Specific” without the prior
written consent of Renesas Electronics. Further, you may not use any Renesas Electronics product for any application for
which it is not intended without the prior written consent of Renesas Electronics. Renesas Electronics shall not bein any way
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an
application categorized as “ Specific” or for which the product is not intended where you have failed to obtain the prior written
consent of Renesas Electronics. The quality grade of each Renesas Electronics product is “ Standard” unless otherwise
expressly specified in a Renesas Electronics data sheets or data books, etc.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual
equipment; home electronic appliances, machine tools; personal electronic equipment; and industrial robots.
“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support.
“Specific”: Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or heathcare
intervention (e.g. excision, etc.), and any other applications or purposes that pose adirect threat to human life.
Y ou should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics,
especialy with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or
damages arising out of the use of Renesas Electronics products beyond such specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further,
Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to
guard them against the possibility of physica injury, and injury or damage caused by fire in the event of the failure of a
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system
manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS
Directive. Renesas Electronics assumes no liability for damages or losses occurring as aresult of your noncompliance with
applicable laws and regulations.

This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas
Electronics.

Please contact a Renesas Electronics sdes office if you have any questions regarding the information contained in this
document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics’ as used in this document means Renesas Electronics Corporation and also includes its majority-

owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.




To all our customers

Regarding the change of names mentioned in the document, such as Hitachi
Electric and Hitachi XX, to Renesas Technology Corp.

The semiconductor operations of Mitsubishi Electric and Hitachi were transferred to Renesas
Technology Corporation on April 1st 2003. These operations include microcomputer, logic, analog
and discrete devices, and memory chips other than DRAMSs (flash memory, SRAMs €tc.)
Accordingly, although Hitachi, Hitachi, Ltd., Hitachi Semiconductors, and other Hitachi brand
names are mentioned in the document, these names have in fact all been changed to Renesas
Technology Corp. Thank you for your understanding. Except for our corporate trademark, logo and
corporate statement, no changes whatsoever have been made to the contents of the document, and
these changes do not constitute any alteration to the contents of the document itself.

Renesas Technology Home Page: http://www.renesas.com

Renesas Technology Corp.
Customer Support Dept.
April 1, 2003
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Cautions

Keep safety first in your circuit designs!

1

Renesas Technology Corporation puts the maximum effort into making semiconductor products better
and more reliable, but there is aways the possibility that trouble may occur with them. Trouble with
semiconductors may lead to personal injury, fire or property damage.

Remember to give due consideration to safety when making your circuit designs, with appropriate
measures such as (i) placement of substitutive, auxiliary circuits, (ii) use of nonflammable material or
(iii) prevention against any malfunction or mishap.

Notes regarding these materials

1

These materials are intended as areference to assist our customersin the selection of the Renesas
Technology Corporation product best suited to the customer's application; they do not convey any
license under any intellectual property rights, or any other rights, belonging to Renesas Technology
Corporation or athird party.

Renesas Technology Corporation assumes no responsibility for any damage, or infringement of any
third-party'srights, originating in the use of any product data, diagrams, charts, programs, algorithms, or
circuit application examples contained in these materials.

All information contained in these materials, including product data, diagrams, charts, programs and
algorithms represents information on products at the time of publication of these materials, and are
subject to change by Renesas Technology Corporation without notice due to product improvements or
other reasons. It istherefore recommended that customers contact Renesas Technology Corporation
or an authorized Renesas Technology Corporation product distributor for the latest product information
before purchasing a product listed herein.

The information described here may contain technical inaccuracies or typographical errors.

Renesas Technology Corporation assumes no responsibility for any damage, liability, or other loss
rising from these inaccuracies or errors.

Please also pay attention to information published by Renesas Technology Corporation by various
means, including the Renesas Technology Corporation Semiconductor home page
(http://www.renesas.com).

When using any or al of theinformation contained in these materials, including product data, diagrams,
charts, programs, and algorithms, please be sure to evaluate all information as atota system before
making afinal decision on the applicability of the information and products. Renesas Technology
Corporation assumes no responsibility for any damage, liability or other loss resulting from the
information contained herein.

Renesas Technology Corporation semiconductors are not designed or manufactured for usein adevice
or system that is used under circumstances in which human lifeis potentially at stake. Please contact
Renesas Technology Corporation or an authorized Renesas Technology Corporation product distributor
when considering the use of a product contained herein for any specific purposes, such as apparatus or
systems for transportation, vehicular, medical, aerospace, nuclear, or undersea repeater use.

The prior written approval of Renesas Technology Corporation is necessary to reprint or reproduce in
whole or in part these materials.

If these products or technologies are subject to the Japanese export control restrictions, they must be
exported under a license from the Japanese government and cannot be imported into a country other
than the approved destination.

Any diversion or reexport contrary to the export control laws and regulations of Japan and/or the
country of destination is prohibited.

Please contact Renesas Technology Corporation for further details on these materials or the products
contained therein.
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Cautions

Hitachi neither warrants nor grants licenses of any rights of Hitachi’s or any third party’s pa|tent,

copyright, trademark, or other intellectual property rights for information contained in this
document. Hitachi bears no responsibility for problems that may arise with third party’s rigt
including intellectual property rights, in connection with use of the information contained in
document.

Products and product specifications may be subject to change without notice. Confirm that
have received the latest product standards or specifications before final design, purchase ¢

Hitachi makes every attempt to ensure that its products are of high quality and reliability.

s,
this

you
r use.

However, contact Hitachi's sales office before using the product in an application that demands

especially high quality and reliability or where its failure or malfunction may directly threate
human life or cause risk of bodily injury, such as aerospace, aeronautics, nuclear power,
combustion control, transportation, traffic, safety equipment or medical equipment for life s

Design your application so that the product is used within the ranges guaranteed by Hitach
particularly for maximum rating, operating supply voltage range, heat radiation characterist
installation conditions and other characteristics. Hitachi bears no responsibility for failure o
damage when used beyond the guaranteed ranges. Even within the guaranteed ranges, ¢
normally foreseeable failure rates or failure modes in semiconductor devices and employ s
measures such as fail-safes, so that the equipment incorporating Hitachi product does not
bodily injury, fire or other consequential damage due to operation of the Hitachi product.

. This product is not designed to be radiation resistant.

No one is permitted to reproduce or duplicate, in any form, the whole or part of this docum
without written approval from Hitachi.

. Contact Hitachi's sales office for any questions regarding this document or Hitachi semicon
products.
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IMPORTANT INFORMATION
READ FIRST

* READ this user's manual before using this CPU board.
« KEEP the user's manual handy for future reference.

Do not attempt to use the CPU board until you fully understand its mechanism.

CPU Board:

Throughout this document, the term "CPU board" shall be defined as the following products
produced only by Hitachi, Ltd. excluding all subsidiary products.

e CPU board

» Serial cable

* AC power cable

* AC power adapter

The user system or a host computer is not included in this definition.

Purpose of the CPU Board:

This CPU board is a software and hardware development tool for systems employing the Hitachi
microcomputer SH7751. Simple debugging functions such as debugging, performance evaluation, and
development of the user system including the SH7751 are enabled by connecting the CPU board to a
host computer. In addition, expansion boards can be installed in the slots; therefore, memory and 1/0
can be expanded. However, this CPU board must not be installed in user products to be used as part of
the user products; it is limited to debugging and evaluation of user systems. This CPU board must only
be used for the above purpose.

Limited Applications:

This CPU board is not authorized for use in MEDICAL, atomic energy, aeronautical or space
technology applications without consent of the appropriate officer of a Hitachi sales company. Such
use includes, but is not limited to, use in life support systems. Buyers of this CPU board must notify
the relevant Hitachi sales offices before planning to use the product in such applications.

Improvement Policy:

Hitachi, Ltd. (including its subsidiaries, hereafter collectively referred to as Hitachi) pursues a policy
of continuing improvement in design, performance, and safety of the CPU board. Hitachi reserves the
right to change, wholly or partially, the specifications, design, user's manual, and other documentation
at any time without notice.

Target User of the CPU Board:

This CPU board should only be used by those who have carefully read and thoroughly understood
the information and restrictions contained in the user's manual. Do not attempt to use the CPU board
until you fully understand its mechanism.

It is highly recommended that first-time users be instructed by users that are well versed in the
operation of the CPU board.

Rev. 1.0, 09/00, page | of VI
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LIMITED WARRANTY

Hitachi warrants its CPU board to be manufactured in
accordance with published specifications and free from defects in
material and/or workmanship. Hitachi, at its option, will repair or
replace any CPU board returned intact to the factory, transportation
charges prepaid, which Hitachi, upon inspection, determine to be
defective in material and/or workmanship. The foregoing shall
constitute the sole remedy for any breach of Hitachi's warranty.
See the Hitachi warranty booklet for details on the warranty period.
This warranty extends only to you, the original Purchaser. It is not
transferable to anyone who subsequently purchases the CPU board
from you. Hitachi is not liable for any claim made by a third party or
made by you for a third party.

DISCLAIMER

HITACHI MAKES NO WARRANTIES, EITHER EXPRESS
OR IMPLIED, ORAL OR WRITTEN, EXCEPT AS PROVIDED
HEREIN, INCLUDING WITHOUT LIMITATION THEREOF,
WARRANTIES AS TO MARKETABILITY,
MERCHANTABILITY, FITNESS FOR ANY PARTICULAR
PURPOSE OR USE, OR AGAINST INFRINGEMENT OF ANY
PATENT. IN NO EVENT SHALL HITACHI BE LIABLE FOR
ANY DIRECT, INCIDENTAL OR CONSEQUENTIAL
DAMAGES OF ANY NATURE, OR LOSSES OR EXPENSES
RESULTING FROM ANY DEFECTIVE CPU BOARD, THE
USE OF ANY CPU BOARD, OR ITS DOCUMENTATION,
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. EXCEPT AS EXPRESSLY STATED
OTHERWISE IN THIS WARRANTY, THIS CPU BOARD IS
SOLD "AS IS ", AND YOU MUST ASSUME ALL RISK FOR
THE USE AND RESULTS OBTAINED FROM THE CPU
BOARD.

Rev. 1.0, 09/00, page Il of VI
RENESAS



State Law:

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental
or consequential damages, so the above limitation or exclusion may not apply to you. This warranty
gives you specific legal rights, and you may have other rights which may vary from state to state.

The Warranty is Void in the Following Cases:

Hitachi shall have no liability or legal responsibility for any problems caused by misuse, abuse,
misapplication, neglect, improper handling, installation, repair or modifications of the CPU board
without Hitachi's prior written consent or any problems caused by the user system.

All Rights Reserved:

This user's manual and CPU board are copyrighted and all rights are reserved by Hitachi. No part of
this user's manual, all or part, may be reproduced or duplicated in any form, in hard-copy or machine-
readable form, by any means available without Hitachi's prior written consent.

Other Important Things to Keep in Mind:

1. Circuitry and other examples described herein are meant merely to indicate the characteristics and
performance of Hitachi's semiconductor products. Hitachi assumes no responsibility for any
intellectual property claims or other problems that may result from applications based on the
examples described herein.

2. No license is granted by implication or otherwise under any patents or other rights of any third
party or Hitachi.
Figures:
Some figures in this user's manual may show items different from your actual system.
Limited Anticipation of Danger:

Hitachi cannot anticipate every possible circumstance that might involve a potential hazard. The
warnings in this user's manual and on the CPU board are therefore not all inclusive. Therefore, you
must use the CPU board safely at your own risk.

Rev. 1.0, 09/00, page Il of VI
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SAFETY PAGE
READ FIRST

* READ this user's manual before using this CPU board.

« KEEP the user's manual handy for future reference.

Do not attempt to use the CPU board until you fully understand its mechanism.

DEFINITION OF SIGNAL WORDS

A This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

A DANGER DANGER indicates an imminently hazardous situation which, if not

avoided, will result in death or serious injury.

A WARNING WARNING indicates a potentially hazardous situation which, if not
avoided, could result in death or serious injury.

|A CAUTION | CAUTION indicates a potentially hazardous situation which, if not
avoided, may result in minor or moderate injury.

| CAUTION | CAUTION used without the safety alert symbol indicates a

potentially hazardous situation which, if not avoided, may result
in property damage.

NOTE emphasizes essential information.

Rev. 1.0, 09/00, page IV of VI
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A\ WARNING

Observe the precautions listed below. Failure to do so
will result in a FIRE HAZARD and will damage the user
system and the CPU board or will result in PERSONAL
INJURY. The USER PROGRAM will be LOST.

1. Always satisfy the power supply conditions which are
described in the manual. Ensure that there are no short
circuits between VCC and GND. Do not apply voltage
that is outside the guaranteed range.

2. Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES,
connectors, or jumpers.

3. When turning on the CPU board or the user system,
take care that conductive material does not touch the
CPU board or the user system.

4. Check that the pin numbers on the connectors of the
CPU board and those on the user system are correctly
aligned before connecting the CPU board and the user
system.

Rev. 1.0, 09/00, page V of VI
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Preface

Thank you for purchasing the CPU board for Hitachi's SH7751 microcomputer.

The CPU board is an efficient development tool for software and hardware of systems based on
Hitachi’'s SH7751 microcomputer.

This manual explains the functions and method of operation of the CPU board.

Section 1, Overview, describes the hardware system configuration and explains environment settings
to enable board use.

Section 2, Preparations Before Use, explains procedures for using the CPU board, HDI installation,
various connections, and the power supply specifications.

Section 3, Tutorial, introduces the major HDI features while demonstrating methods for loading and
debugging a C language program.

Section 4, Descriptions of Windows, describes each of the windows used in the HDI.

Section 5, CPU Board Specifications, explains the specifications of the CPU board, the memory map,
interfaces with external equipment, and CPU board initialization.

Section 6, Notes and Troubleshooting, explains important information regarding use and gives
suggestions for troubleshooting.

Section 7, Creation of User Interrupt Handlers, explains how to create an original interrupt handler
routine.

Please read this manual completely in order to gain a thorough understanding of this product’s
functions and performance.

The text appearing in the various windows of the HDI may differ from those appearing in this manual
depending on the language of the OS being used. The figures appearing in this manual are for the
Microsoft’ Windows' 98.

Related Manuals

* SH7751 Hardware Manual

e SH4 Programming Manual

* SH Series Cross Assembler User’'s Manual

* SH Series C Compiler User’'s Manual

e SH Series Simulator/Debugger User’'s Manual

« Hitachi Debugging Interface User's Manual (available in the CD-R supplied with this CPU board)

When connecting an E10A emulator to the CPU board, the following manual should also be read.

Rev. 1.0, 09/00, page i of x
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 SH7751 E10A Emulator User’'s Manual

Notes: 1. IBM PC is a registered trademark of International Business Machines Corporation in the
United States.
2. Microsoft’, Windows’, and WindowsNT are registered trademarks of Microsoft
Corporation in the United States and/or other countries.
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Section 1 Overview

1.1 Features

The SH7751 CPU board (hereafter, referred to as the CPU board) supports the evaluation of the
functions and performance of the Hitachi SH7751 microcomputer, and the development and
evaluation of systems that incorporate the SH7751.

The features of this CPU board are as follows:

e Supports user expansion boards
Has an expansion connector for I/O of signals conforming to the SH7751 external bus
specifications, to which an expansion board developed by the user to increase memory and I/O can
be connected and evaluated.

» Supports the maximum operating frequency
Allows evaluation at 167 MHz and 83.5 MHz, which are the maximum internal and external
operating frequencies of the SH7751, respectively.

* Host Interface
For interfacing with IBM PC compatible as the host computer, one channel of serial interface (that
conforms to RS-232C) is provided. The Hitachi Debugging Interface (HDI) is also provided as host
interface software.

» Enables user-program evaluation
Up to 63.5 Mbytes of a user program can be loaded into the user memory and be evaluated.

e Support for compact PCI interface
The SH7751 provides PCI interface functions. The CPU board outputs the on-chip PCI bus
interface signals through the compact PCI connector. This interface conforms to the PICMG2.0
rev.2.1, and the CPU board functions can be easily expanded by connecting to a standard
backplane.

e

= & r 4
ui%%%%%%%%{sﬁfa

SRR

Figure 1.1 CPU Board, External View
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1.2 System Configuration
The system configuration of the CPU board is shown in figure 1.2.
The following items are required to use the CPU board.

e IBM PC compatible machine: One for the monitor command input and output.

* One serial interface cable: Use the provided cable.
» One AC power supply adapter: Use the provided adapter.
* One AC power supply cable: Use the provided power cable.

AC power

supply
adapter

CPU board

Serial interface cable

IBM PC compatible

Figure 1.2 CPU Board System Configuration
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1.3 Warnings

CAUTION

READ the following warnings before using the CPU board.
Incorrect operation will damage the user system and
the CPU board. The USER PROGRAM will be LOST.

1. Check all components against the component list after unpacking the CPU board.
2. Never place heavy objects on the CPU board.

3. Protect the CPU board from excessive impacts and stresses. For details, refer to section 1.6,
Environmental Conditions.

4. Do not connect any cable or connector other than specified ones to the CPU board.

5. When moving the host computer or user expansion board, take care not to vibrate or damage the
CPU board.

6. After connecting the cable, check that it is connected correctly. For details, refer to section 2,
Preparation before Use.

7. Supply power to the connected equipment after connecting all cables. Cables must not be
connected or removed while the power is on.
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1.4 Components

Table 1.1 lists the components of the CPU board. Check all components after unpacking.

Table 1.1 CPU Board Component List

Item View

Quantity Remarks

CPU board

One printed circuit
board

AC power

supply adapter @

AC power

supply cable ﬁ_ﬂz

Serial interface

cable @\S_\@

Jumper

]

Front panel For use in a compact

PCI rack.
Debug Serial Port LAN I/F H H
MRST PRSTABORT prOVIded with handles
ooo []
CD-R One CD-R;
(HDI installer) @ Model number
E— HS7751STCO1SR

(contains CPU board
manual and HDI
manual)

SH7751 CPU One Japanese

Board
Installation
Guide
—

version and one
English version;
Japanese:
HS7751STCO1HJ-P,
English:
HS7751STCO1HE-P
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1.5 CD-R Contents

The supplied CD-R includes software and user's manuals for the SH7751 CPU board as listed in table

1.2.
Table 1.2 CD-R Contents
Directory File Name Contents Remarks
\Setup Setup.exe HDI installer
\Manuals\Japanese HS7751STCO1HJ.pdf SH7751 CPU Board PDF document in
User's Manual Japanese
Type No.:
HS7751STCO1HJ
\Manuals\Japanese HS6400DIIW5SJ.pdf Hitachi Debugging PDF document in
Interface User's Japanese
Manual Type No.:

HS6400DIIW5SJ

\Manuals\English

HS7751STCO1HE.pdf

SH7751 CPU Board

PDF document in

User's Manual English
Type No.:
HS7751STCO1HE
\Manuals\English HS6400DIIW5SE.pdf Hitachi Debugging PDF document in
Interface User's English
Manual Type No.:

HS6400DIIW5SE

\Pdf_read\Japanese

Ar40jpn.exe

Acrobat® Reader
installer

Japanese version

\Pdf_read\Englsih

Ar40eng.exe

Acrobat® Reader
installer

English version

Note:

To read a PDF document, use the Acrobat® Reader.

RENESAS
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1.6 Environmental Conditions

CAUTION

Observe the conditions listed in tables 1.3 and 1.4 when
using the CPU board. Failure to do so will damage the
user expansion board and the CPU board. The USER
PROGRAM will be LOST.

Table 1.3  Environmental Conditions
Item Specifications
Temperature Operating: +10°C to +35°C
Storage: -10°Cto +50°C
Humidity Operating: 35% RH to 80% RH, no condensation
Storage: 35% RH to 80% RH, no condensation
Vibration Operating: 2.45 m/s” max.
Storage: 4.9 m/s” max.

Transportation: 14.7 m/s’ max.

Ambient gases

There must be no corrosive gases present

Table 1.4

Item

Operating Environments

Description

Host computer

Built-in Pentium or higher-performance CPU (200 MHz or higher
recommended); IBM PC or compatible machine.

(ON]

Windows® 95, Windows® 98, or Windows NT®

Minimum memory
capacity

32 Mbytes or more (double of the load module size recommended)

Hard-disk capacity

Installation disk capacity: 5 Mbytes or more. (Prepare an area at least
double the memory capacity (four-times or more recommended) as the
swap area.)

CD-ROM drive

Required to install the HDI.

Pointing device such as
mouse

Connectable to the host computer; compatible with Windows® 95,
Windows® 98, and Windows NT®.

Power voltage

(AC power supply
adapter)

Input: 100 to 240 VAC, 50/60 Hz, 0.6 A max.
Output: +5 VDC 5 A

Rev. 1.0, 09/00, page 6 of 138
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Section 2 Preparation before Use

2.1 CPU Board Preparation

A\ WARNING

READ the reference sections shaded in figure 2.1 before
using the CPU board product. Incorrect operation will damage
the CPU board and the user expansion board. The USER
PROGRAM will be LOST.

Unpack the CPU board and prepare it for use as follows:

Reference

Unpack the CPU board.
1

Check the components against
the component list.
1

Component list

Turn on the host computer.

Procedure

_ when the CPU
Install the HDI. Section 2.2 board is used first.

Turn off the host computer.

Connect the CPU board to the host
computer and AC power supply adapter,
and when necessary to a Compact PCI
back plane or user expansion board.
Also be sure to set the jumper on

the CPU board.

Section 2.3t0 2.8

Turn on the host computer. Procedure
when the CPU

I board is used
Turn on the CPU board. Section 3 for second time
T or later.

Start the HDI.

Figure 2.1 CPU Board Preparation Flow Chart

Rev. 1.0, 09/00, page 7 of 138
RENESAS




2.2 HDI Installation
An example of installing the HDI on an IBM PC compatible machine is described in this section.

Start [Setup.exe] in the \Setup directory of the HDI installer CD-R. If any other application is running,
close it before starting the HDI installer.

Figure 2.2 [Setup.exe] Icon

This runs the HDI installer. A dialog box will first prompt you to select a language for the installation
process. Select a language then continue according to the instructions displayed by the installer.

Note: Under Windows N¥4.0, install the HDI in the administrator mode.

HDI Installation Directory: The default directory for installing the HDI depends on whether the
Hitachi Embedded Workshop (HEW) has been installed in the host computer, as shown in table 2.1

Table 2.1  Default Installation Directory

HEW Program Default Installation Directory
HEW has not been installed C:\Hdi5_ch\7751
HEW has been installed C:\Hew\Hdi5\Cb\7751

(in this example, in C:\HEW)

Backup File: If another version of HDI has already been installed, a message "The HDL.INI file has
already existed. Can it be overwritten?" will be displayed. Clicking [Yes] will make a backup of the
existing file in the Backup directory of the installation directory.

When installation is complete, [HDI for SH7751 CPU board] can be selected from the start menu.

Rev. 1.0, 09/00, page 8 of 138
RENESAS



a

FE] P

ES Hdiald b
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Help
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: : @ Windows Explorer

Figure 2.3 Start Menu

2.3 HDI Uninstallation
Uninstall the HDI for the SH7751 CPU board as follows:

Select [Settings] from the Start menu, then select [Control Panel].

Select [Add/Remove Programs].

Select [HDI for SH7751 CPU board] from the application list, then click [Add/Remove].
A confirmation message will be displayed, and the uninstallation procedure will start.

powbdPE
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2.4 Connecting Cables

Figures 2.4 to 2.6 show how to connect interface cables to the CPU board.

A\ WARNING

Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES,
CONNECTORS, or JUMPERS. Failure to do so will result in a
FIRE HAZARD and will damage the user system and the CPU
board or will result in PERSONAL INJURY. The USER PROGRAM
will be LOST.

E10A
2z user system
interface cable

""""""""" Connect to CN23

CPU board

Figure 2.4 E10A User System Interface Cable Connection
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(4
=) <

Connect to CN15

Serial
interface
cable

Figure 2.5 Serial Interface Cable Connection

A\ WARNING

Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES. Failure to do
so will result in a FIRE HAZARD and will damage the user
expansion board and the CPU board or will result in PERSONAL
INJURY. The USER PROGRAM will be LOST.

J—
;g%ﬁu%‘i%%%%%::}i%&“
& § [ Connect to CN3

F S
Shihnnoonnanaanan s
oy

from AC adapter

/ CPU board

Figure 2.6 AC Adapter Connection
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2.5 Connecting the User Expansion Board

Figure 2.7 shows how to connect the user expansion board.

A\ WARNING

Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES,
CONNECTORS, or JUMPERS. Failure to do so will result in a
FIRE HAZARD and will damage the user system and the CPU
board or will result in PERSONAL INJURY. The USER PROGRAM
will be LOST.

2%,

CPU board

Figure 2.7 User Expansion Board Connection (CN1)
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2.6 Connecting the Compact PCI Backplane

Figure 2.8 shows how to connect the compact PCI backplane.

A\ WARNING

Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES,
CONNECTORS, or JUMPERS. Failure to do so will result in a
FIRE HAZARD and will damage the user system and the CPU
board or will result in PERSONAL INJURY. The USER PROGRAM
will be LOST.

Compact PCI backplane .
(commercially available) System\slot EXWOE
\ A AN
\ N AR 20N

[m|

N B
D e

CPU board Commercially available

PCI board

Figure 2.8 Compact PCI Backplane Connection

The CPU board can be used as a system board for compact PCI. Install the CPU board in the system
board slot of the backplane. The 3.3V, 33MHz, and 32bit interface is supported. Up to four expansion
slots can be controlled.

Before installing the CPU board in the backplane, remove the spacers and attach the front panel as
shown in figures 2.9 and 2.10. Do not lose the spacers and screws removed.
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Figure 2.9 Spacer Removal
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Figure 2.10 Front Panel Attachment
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2.7 Switches

Table 2.2 lists the switches used in the CPU board and figure 2.11 shows where the switches are located
(on the CPU board).

Table 2.2  Switch Specifications

Switch Symbol Type Function

Power supply SW1 Rocker Turns on and off the 5 V power supplied to the

switch switch CPU board. Turn off this switch when connecting
to the compact PCI backplane.

Manual reset SW2 Push button  Forcibly initializes the system. Use this switch

switch (red) when the system does not operate correctly, for

example, when the user program goes out of
control. The BSC settings are not initialized.

Power-on reset SW3 Push button  Forcibly initializes the system. Use this switch

switch (white) when the system does not operate correctly, for
example, when the user program goes out of
control. The BSC settings are reset to the HDI
initial settings.

Abort switch sSw4 Push button  Forcibly aborts the command currently being
(black) executed. When this button is pressed while the
user program is being executed, the CPU board
stops execution and returns to the monitor
program command wait state.

CPU board

/ Power-on reset switch Abort switch

Manual reset switch

Figure 2.11 Switch Location
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2.8 Jumpers
The CPU board has 33 locations for jumpers: J11 to J16, J21 to J2A, J31 to J36 and J41 to J4B.

e Jl1toJ16: For testin Hitachi. No jumpers are mounted.

» J21to J21A: For specifying the CPU board operating mode. J21, J23 and J25 to J27 are mounted.
» J31toJ36: For specifying expansion functions. J35 and J36 are mounted.

e J41toJ4B: For specifying the SH7751 modes. J42, J46, J49, J4A, and J4B are mounted.

Table 2.3 shows jumper settings. In the table, the initial settings at shipment are shaded. The reserved
settings must not be used. Figure 2.12 shows how to insert a jumper pin.

A WARNING

Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES,
CONNECTORS, or JUMPERS. Failure to do so will result in a
FIRE HAZARD and will damage the user system and the CPU
board or will result in PERSONAL INJURY. The USER PROGRAM
will be LOST.
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Table 2.3  Jumper Settings

Symbol Function Setting Description

J21 Base clock 1-2 closed Reserved (must not be used)

J23 Bus frequency Closed CPU internal frequency 167 MHz

Bus frequency 55.7 MHz

CPU on-chip module frequency 27.8 MHz

J25 Resource for area 0 Closed EPROM (socket) connected. Flash memory is
connected to area 2.

J26 Expansion bus Closed Area 2 released to the user expansion board
area 2 interface

J27 Expansion bus
area 4
Open Area 4 cannot be used
2-3 closed Reserved (must not be used)
J36 Serial interface Closed 57,600 bit/s
baud rate
Open Reserved (must not be used)
Open Little endian
Open Reserved (must not be used)
Open Reserved (must not be used)

Open PCI function disabled

Note: When the EPROM is selected by J25, area 2 becomes the flash memory area regardless of the
J26 setting, and the expansion bus area cannot be accessed in area 2. The CSO0 bus width is
switched between 32 bits (flash memory is connected) and 16 bits (EPROM is connected) by
the J25 setting.
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2.9 Power Supply

29.1 Power-Supply Specifications

Figure 2.13 shows the power-supply specifications, and figure 2.14 shows the block diagram of the
power-supply section.

5V (Vin) 5.0V
_______ 3.3V (Vout)
. 1.8 V (CPU) 32Y

20 ms (reference value)
-t -

-t |
50 ms

Power-on reset_N

Figure 2.13 Power-Supply Specifications

—SH7751 CPU board

CN3
Power SW1 o
+5V | connector N_SWi1-1
ono Lot B sy
—P GND
1o
OFF 5V
CN19 On-board logic IGND
Expansion

CN20

+5V PCI +5V il /—/l/ Szrinector
P connector
in | L7084 oy |on_SWI-2 SH7751 CPU P 33y
5V->33V k n LT1084 veoIo
a3y Regulator O 3.3V -> 1.8 V]out
+3.
ﬂ’ 0 Regulator vee
OFF 7; GND
18V

GND GND >

SW1-1 and SW1-2 are included in one component.
| They are switched on or off at the same time.

Figure 2.14 Power-Supply Section Block Diagram
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29.2 Connecting the Power Supply Cable

Power should always be supplied to the CPU board using the provided AC power supply adapter and
AC power supply cable. The method of connection is shown in figures 2.15 and 2.16.

A WARNING

Observe the precautions listed below. Failure to do so
will result in a FIRE HAZARD and will damage the user
system and the CPU board or will result in PERSONAL
INJURY. The USER PROGRAM will be LOST.

1. Always use the provided AC power supply adapter.

2. Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES,
CONNECTORS, or JUMPERS.

GND

Vee(5V)
CN3 /
_| PCB

| ]
 E—

Figure 2.15 Front View of Power Supply Connector

Rev. 1.0, 09/00, page 21 of 138
RENESAS



LG i <}:|

CPU board top view

Figure 2.16 AC Power Supply Adapter Connection
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Section 3 Tutorial

3.1 Introduction
The following describes the main features of the HDI by using a tutorial program.

The tutorial program is based on the C program that sorts ten random data items in ascending or
descending order.

The tutorial program is included in t&®rt.c  file in the HDI installer CD-R. The compiled load
module is provided in the SYSROF format and is included irstreabs file.

The tutorial program is automatically installed when the HDI is installed.
Table 3.1 lists the tutorial program configuration.

Table 3.1  Tutorial Program Configuration

Item Contents
Tutorial file (load module) (install directory)\Tutorial\Sort.abs
Tutorial file (source file) (install directory)\Tutorial\Sort.c

This sample program uses the RAM area starting from address H'0C000000. The MMU function is
not used.

Notes: 1. Sort.abs operates in big endiaBort.abs must be recompiled to operate in little
endian.
2. The work space for this tutorial program was created using Version 1.1a (Release 3) of
Hitachi Embedded Workshop (HEW).
Hitachi SH C/C++ compiler version 5.1B
Hitachi SH IM OptLinker version 1.1B
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3.2 Running the HDI

To run the HDI, select the [HDI for SH7751 CPU Board] from the [Start] menu.

s dan
' Hdiald

Hitachi Embedded Workshop
HO! for Internet E=plorer

EaJ

%Windnws Update Microzoft Input Devices
—p n Bs HOI for SH7751 CPU board  *| BRI HO! for SH7751 CPU board
& Programs
r_ . .
= : Online Services
SH7750m
% Documents r
; Startlp
53 Setings | I 5 7751EH
3 Find i
i )
@ ﬁ Load
gﬂun... A
MS-D0S Prompt
L‘-E% Log Off Adrninistrator... B4 zh7709
@ Shut Draw... B9 sh77e0_1

(2] windaws Explarer

Figure 3.1 [Start] Menu

The [HDI] window will open, then the [Select Session] dialog box will appear. Check that the setting
shown in figure 3.2 is complete, and click the [OK] button.

% Create a new session ond
|SH7751 GPU board [~

" Previous =sesszion file:

I - | Erovwse.,

I

Figure 3.2 [Select Session] Dialog Box
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The message box shown in figure 3.3 will appear. Check that the CPU board power is turned on, and
click the [OK] button.

HDI

& Please power on the GPL board and press <Enter> kew.

Figure 3.3 Power Supply Confirmation Message Box
WhenLink up appears in the message box, HDI startup is completed.
If Link up does not appear, check the items listed in table 3.2.

Table 3.2 Check Items When HDI Cannot Be Initiated

Check Item Reference in this Manual
Check that the power monitoring LED (D22) on the CPU board is Section 5.7

turned on.

Check that the host computer and the CPU board are correctly Sections 2.4 and 5.4.1

connected through a serial cable.

Check that the port and baud rate are set correctly in the [Monitor Sections 3.5and 4.2.1
Setup] dialog box.

Check that the jumper pins are correctly inserted into the jumpers Section 2.8
on the CPU board.
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3.3 [HDI] Window

ig dmterface — sort — SH77E1 GPU board

Eile Edit Wiew Bun Memory Setup Window Help
#, Lo ||EF ELED R e B TR &
mws z @A

Gl G B B || 22

7 —

D— ||k
e snsm
[ B &
@ Line [fddress
o || 0c000000
e
@ T0
2 | B
12
fgb 13
14 0c000004
2 |[15  ocoooooe
w |[16  ocooooie
“» 1117 0cooonzo
& | s
19 0c000024
20
71 DcODDO4D
& (|22 0c000050
73 0c000054
B ||za  ocooooss
75 0c00D0Ge
KI

BP [Lahel

_main

dource
void main(vaoid)

lang all0];
long js
int i, min, max;

@H For Help, press F1

The key features of the HDI are described in section 4, Descriptions of Windows. Numbers in figure

3.4 indicate the following:

Figure 3.4 [HDI] Window

Menu bar: Gives the user access to the HDI commands for using the HDI debugger.

1

2. Toolbar: Provides convenient buttons as shortcuts for the most frequently used menu commands.
3. Program window: Displays the source program being debugged.

4. Status bar: Displays the status of the CPU board, and progress information about downloading.

5

[Help] button: Activates on-line help about any features of the HDI user interface.
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3.4 Setting up the CPU Board
The following conditions can be set up on the CPU board before downloading the program:

» Connection method
* |/O definition file
« Options on program load

The following describes how to set up the CPU board for the tutorial programs.

3.5 Setting the [Monitor Setup] Dialog Box

» Select [Configure Platform...] from the [Setup] menu to set configuration. The [Monitor Setup]
dialog box is displayed.

Monitor Setup

— Target Monitor Comme S ettings
1] 4

Comms Part;

Cancel
Baud Rate: [775000 = .

10 definition file: ISH??E'] Browse. ..

I Dovnload with werify

[ el

[ Delete breakpointz when program is reloaded

[ Beset CPU when program has been downloaded

Figure 3.5 [Monitor Setup] Dialog Box

Notes: 1. The I/O register definition file can be selected in this dialog box. Be sure to select a file
within the HDI installation directory. Otherwise, the 1/O register window will not operate
correctly.

2. The name of the I/O register definition file can consist of up to nine characters. This
number does not include the file name's extension.
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e Set options as follows:

Table 3.3  Setting the [Monitor Setup] Dialog Box

Option Default Value

Comms Port: COM1: Select from among COM1, COM2, COM3, or COM4 as the
host computer serial port.

Baud Rate: 115200 Sets the serial baud rate. Select either 57600 bit/s or 115200
bit/s, to match the setting of jumper J36. Connection is not
possible at any other setting.

1/0O definition file SH7751 Sets the I/O register definition file. The SH7751 definition file
is set as default. On selecting a file, the [I/O Registers]
window (accessed from the [View] menu) can be used to
display register information.

Download with verify - The CPU board does not support this function (this box
cannot be selected).

Delete breakpoints Unchecked When this box is checked, all breakpoints are deleted when

when program is a program is reloaded.

reloaded

Reset CPU when Unchecked When this box is checked, registers are initialized* when a

program has been
downloaded

program is loaded. No reset signal is input to the CPU board.

Note:

Initialized as follows: PC = H'AC000000, SR = H'600000EO, and VBR = H'A0080000 (big

endian) or H'A0100000 (little endian).

» Click the [OK] button.
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3.6 Downloading the Tutorial Program

3.6.1 Downloading the Tutorial Program
Download the object program to be debugged.

» Select [Load Program...] from the [File] menu. The [Load Program] dialog box is displayed. Enter
the offset and file name in the [Offset] edit box and [File name] list box as shown in figure 3.6 and
click the [Open] button.

Load Program !

Offset; Open |
H'D i
i M erify Cancel I

File name:

IE:'\Hew'deiE"-.EI:n'x??ﬂ'xTutn:nriaI'xS-:nrt.aI:-s :_i i Browse.. |

™ Load only debugging information
™ Load stack information filefSMI file]

Figure 3.6 [Load Program] Dialog Box

When the file has been loaded, the following message box displays information about the memory
areas that have been filled with the program code.

HDI i

Module name: C:8Hew \HAEACESNFFET4T utorialhSort. abs
Areas loaded:
QCO00000 - 0Co0o1ca
QCOo001CC - oConoio?

Figure 3.7 [HDI] Message Box

» Click the[OK] button to continue.
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3.6.2 Displaying the Source Program
The HDI allows the user to debug a program at the source level.

» SelecfSource...] from the [View] menu. The [Open] dialog box is displayed.
» Select the C source file that corresponds to the object file the user has loaded.

Open

Look jn: I = Tutarial

S ort.ci

File: marme: |S-:|rt.|: Open I
Filez af type: II: Files [*.cinl] j Cancel |
-

Figure 3.8 [Open] Dialog Box

Rev. 1.0, 09/00, page 30 of 138
RENESAS



» Select [Sort.c] and click the [Open] button. The [Program] window is displayed.

Line |&fddress |EF [Label |Source -]
g 0c000000 _main ﬁinid main(void)

g

10 long al10];

11 long j;

12 int i, min, max;

13

14 OcOO0004 far( i=0; i<10; i++ 11

15 Oc00000c i = rand();

16 OcDO00Te if(j < 0)f

17 OcOO00Z0 = -1

13 I

19 Oc000024 ali] = s

20 I

21 0c000040 sort (a); Jﬂ
P b

Figure 3.9 [Program] Window (Displaying the Source Program)

» If necessary, select the [Font] option from the [Customize] submenu on the [Setup] menu to select
a clear font and size.

Initially the [Program] window shows the start of the main program, but the user can use the scroll bar
to scroll through the program to see the other statements.
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3.7 Setting the Software Breakpoint
A breakpoint is one of the easy debugging functions.

The [Program] window provides a very simple way of setting a software breakpoint in a program. For
example, to set a breakpoint at Hmet function call:

» Select by double-clicking the [BP] column on the line containingtiie function call.

Line |fddress |BP [Lahel |Source -]
g 0c000000 _main xJEnid mainivoid)

4

10 long al107;

11 long J;

12 int i, min, max;

13

14 ODcO00004 for( i=0; i<10; i++ )1

15 0c00000¢ i = rand(};

16 Dc00001c ifii <0

17 OcO00020 i=-i; e
18 1

19 ODcO0002 4 ali] = i;

20 1

21 Oc000040 @  Break sort(a);

27 0Dc000050 min = al0];

23 DcO00054 max = al9];

24 Dc000058 min = 0;

25 OcO0005c max = 0;

7B 0c000060 changelal;

27 ODc000070 min = al49];

28 OcO00074 max = al0];

29 Dc000078 1 &
4 b

Figure 3.10 [Program] Window (Setting a Software Breakpoint)

The® Break will be displayed on the line containing thart function to show that a software
breakpoint is set.

Note: The software breakpoint cannot be set in the ROM area or the delay slots in the program.
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3.8 Setting Registers
Set values of the program counter and the stack pointer before executing the program.

» Select [Registers] from the [View] menu. The [Registers] window is displayed.

Register [W¥alue -
RO gooooooo
R1 gooooooo
RZ gooooooo
R3 gooooooo
R4 gooooooo
RE gooooooo
Rb gooooooo
R gooooooo
RE gooooooo
RY gooooooo
R10 gooooooo
R11 gooooooo
R1% gooooooo
R13 gooooooo
R14 gooooooo
R15 AFFE0000
P ACO00000
+ &R Plommmmmmm oo - I11----F
3BR gooooooo -
K LH

Figure 3.11 [Registers] Window
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» To change the value of the program counter, double-click the value area in the [Registers] window
with the mouse. The following dialog box is then displayed, and the value can be changed.

Fegizter - PG

Walle:

0000000 oK |
oet A
[Whole Register =] Cancel

Figure 3.12 [Register] Dialog Box (PE

« EnterH’0C000000 in the [Value] edit box, and click the [OK] button.
» To change the value of the stack pointer, move the mouse pointer to the value area of [R15] in the
[Registers] window and enter a new value directly, or double-click the value area with the mouse

to open the following dialog box.

Fegizter - R15

Walle:

|&FF20000 oK |
oet A
[Whole Register =] Cancel

Figure 3.13 [Register] Dialog Box (SP)

« EnterH’AFF80000 in the [Value] edit box, and click the [OK] button.
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3.9

Executing the Program

Execute the program as described in the following:

» To execute the program, select [Go] from the [Run] menu, or click thebi@tmn on thdoolbar.

Ell

Figure 3.14 [Go] Button

The program will be executed up to the breakpoint that has been set, and a statement will be
highlighted in the [Program] window to show the position that the program has halted. [Break =
Breakpoint] will appear on the status bar.

g

[l — —
LD 00— D0 O e OO D —

Sl e ) ot I ot ) R ot I e I S I e Y
O oD 1 O O e O [0 —

OcO00000

OcO000004
Oc00000c
OcO00001c
OcO000Z0

Oc0000Z4

OcO000040
Oc000050
Oc000054
Oc000058
Oc00005c
0c000060
Oc000070
OcO000074
Oc00007S

Line |fddress |BP

Break

[Lahel

_main

[Source o]
void main(void)
long al10];
long j;
int i, min, max;
fori i=0; i<10; i++ 3
i = rand();
ifli < 00
I =-i; o
1
alil = i;
1
sortlal;
min = al0];
max = al9];
min = 0;
max = 0;
changelal;
min = al9];
} max = all];

Figure 3.15 [Program] Window (Break Status)

The user can see the cause of the break that occurred last time in the [System Status] window.
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Select [Status] from the [View] menu.

The [System Status] window will appear. Open the [Platform] sheet and check the sBxkekof

Cause.

Syztem Status

[ten

Connected tao

CPU

Mode

Cache Status [C/0C
MU Status

[/0 definitian
Clock

Tarzet DLL Yersian
Manitor Yersiaon
Run Status

Break Cause

Run Time Count
Comm port baudrate

[Status

SH4 Wonitar

GHT751 Big Endian

Privilegzed Mode

OFF/OFF

OFF

SHTTEI

CPU: 167 MHz, External Bus: 83.5 MWHz
BLELHEE (nmodd vyvy)

BLORE

Break

Breakpaint

Ok Omin ls Oms 0.0us
RTE00 hit/s

session » Platform £ Memory £ Events /
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The [System Status] window displays the following items in each page.

Table 3.4  Contents of the [System Status] Window
Sheet Item Description
[Session] Target System Indicates whether the CPU board is connected or not.
Session Name Displays the session file name.
Program Name Displays the load module file name.
[Platform] Connected to Displays the name of the connected CPU board
monitor program.
CPU Displays the target CPU and endian setting.
Mode Displays the CPU processor mode (privileged mode or
user mode).
Cache Status IC/OC Shows whether the cache is enabled or disabled.
MMU Status Shows whether the MMU is enabled or disabled.
I/0O definition Displays the selected I/O register definition file.
Clock Displays the clock frequency (CPU operating frequency
and external bus frequency) being used.
Target DLL Version Indicates the version of the target DLL for connection to
the CPU board.
Monitor Version Displays the monitor program version.
Run Status Displays the user program execution status:
Run: Being executed
Break: Stopped
Break Cause Displays the cause of the program stopping at break.
Run Time Count Shows the time from the start of the user program to
the break. When the run time count function is
disabled, "0Oh Omin Os Oms 0.0us" is displayed.
Comm port baudrate Indicates the data baud rate for the serial interface.
[Memory] Target Device Configuration  Not supported by this CPU board.
System Memory Resources Not supported by this CPU board.
Loaded Memory Areas Shows the area where the load module is loaded.
[Events] Resources Shows the number of breakpoints set.
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3.10 Reviewing Breakpoints
The user can see all the breakpoints set in the program in the [Breakpoints] window.

» Select [Breakpointsfom the [View] menu.

Breakpointz

Enable |File/Line [Svmbol [Address |Type
hEnrt.cfﬁl 0CO000040 PC hreakpoint

<] | i

Figure 3.17 [Breakpoints] Window

Right-clicking in the [Breakpoints] window will open a pop-up menu, through which breakpoints can
be set, changed, deleted, enabled, or disabled.

Rev. 1.0, 09/00, page 38 of 138
RENESAS



3.11  Viewing Memory

The user can view the contents of a memory block in the [Memory] window. For example, to view the
memory contents corresponding to thain in word size:

» Select [Memory ...] from the [View] menu, entaain in the [Addressgdit box, and sét/ord in
the [Format] combo box.

DOpen Memory Window
adivess ok |
= (0] 4
main
| Cancel
Format:
|'l.l'u'-:|r|:| ﬂ

Figure 3.18 [Open Memory Window] Dialog Box

» Click the [OK] button. The [Memory] window showing the specified area of memory is displayed.

fddress  Data Yalue -]
gcoopooo 4F22 0 20258 -
gcoopon?  YFCE 32712

gcoonon4 e300 -7424
cononoe  1F32 79566
gcononos  AO01E  -24554
gcononod  oo0nd 4
ocoonone 0264 kg
gcoonooe  Ditc -12004
gcoonolo 2219 87249
gcoonot:  42ed 17002
gpcoonot4  DiTE -12005
gcononte 0103 254
gcononts  oong 4 hd

Figure 3.19 [Word Memory] Window
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3.12  Watching Variables

As the user steps through a program, it is possible to watch that the values of variables used in the user
program are changed. For example, set a watch on the long-typa alealared at the beginning of
the program, by using the following procedure:

» Click the left of displayed array in the [Program] window to position the cursor.

» Click the [Program] window with the right mouse button and select [Instant Watch...] from a pop-
up menu.

The following dialog box will be displayed.

Ihztant YWiatch

T3 = | Uatt (Has |
Add Watch |

Figure 3.20 [Instant Watch] Dialog Box
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» Click [Add Watch] button to add a variable to the [Watch Window] window.

e e Watch Window E !E
Name [Value
ta ={ Ouaffiffdd }

Figure 3.21 [Watch Window] Window (Displaying the Array)
The user can also add a variable to the [Watch Window] window by specifying its name.

» Click the [Watch Window] window with the right mouse button and select [Add Watch...] from
the pop-up menu.

The following dialog box will be displayed.

Bdd Watch

~
Cancel

max

Figure 3.22 [Add Watch] Dialog Box
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« Input variablemax and click the [OK] button.

The [Watch Window] window will now also show the long-type variahix.

« ¢ Watch Window m !E E

Name Value

+a ={ Oxaffiffdd |
max 0°o

Figure 3.23 [Watch Window] Window (Displaying the Variable)

The user can double-click thesymbol to the left of arrag to watch the all elements in array

W ——_—— e —— — ———
B 00 OO =] O LT b 00 D —
e e e e e

=

Figure 3.24 [Watch Window] Window (Displaying Array Elements)
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3.13

Stepping Through a Program

The HDI provides a range of step menu commands that allow efficient program debugging.

Table 3.5 Step Option

Menu

Command Description

Step In Executes each statement, including statements within functions.

Step Over Executes a function call in a single step.

Step Out Steps out of a function, and stops at the statement following the statement in the
program that called the function.

Step... Steps the specified times repeatedly at a specified rate.

Use the [Go] described in section 3.9, Executing the Program, to confirm that the program is executed
up to thesort function statement at address H'0C000040.

RENESAS

Line |&ddress |BF Labe | Lource -

20

21 0cO00040 @ Break sort {a);

22 0c000050 min = al0];

23 0c000054 max = al9];

24 NcO000058 min = 03

2h Nc00005c max = 0;

26 0c000060 change(a);

27 0c000070 min = al9];

28 0c00007 4 max = al0];

29 0000078 1

a0

3 fe0OO0NEE _sort woid sort{lang *a)

3z

33 long t;

a4 int i, J. k., zap;

35

36 0c00008c gap = 9;

a7 0000090 whi|E( zap 0ot

38 IINNEE far ( k k<gap; k++]){

aq 0c00009c fo sk+gap; i<10; i=i+gap )1

41 0c0000a8 for(JZi—gap; i¥zk; j=i-zap)i

41 0c0000b4 if(aljl>ali+gap])] =
Figure 3.25 [Program] Window (Step Execution)
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3.13.1  Executing [Step In] Command
The [Step In] steps into the called function and stops at the first statement of the called function.

» To step through thsort function, select [Step In] from the [Run] menu, or click the [Step In]
button in the toolbar.

&

Figure 3.26 [Step In] Button
Line |&ddress |BF Labe | Suur?e -
20
21 0cO00040 @  Break sart {a);
22 0c000050 min = al0];
23 0c000054 max = al9];
24 NcO000058 min = 03
2h Nc00005c max = 0;
26 0c000060 change(a);
27 0c000070 min = al9];
28 0c00007 4 max = al0];
29 0000078 1
a0
3 Ne0OO0BE _sort ?oid sort (lang *a)
3z
33 long t;
34 int i, J. k., zap;
35
36 Nc00008c zap = h;
a7 0000090 whi|E( zap > [ 11
38 IINNEE for( k=0; k<gap: k++){
39 0c00009c foar( i=k+gap; i<10; i=i+gap J{
41 0c0000a8 forij=i-gap; j»=k; j=j-zap)i
41 0c0000b4 if(aljl>ali+gap])] =

Figure 3.27 [Program] Window (Step In)

« The highlighted line moves to the first statement ofsiie  function in the [Program] window.

Rev. 1.0, 09/00, page 44 of 138
RENESAS



3.13.2  Executing [Step Out] Command

The [Step Out] steps out of the called function and stops at the next statement of the calling statement
in the main function.

» To step out of theort function, select [Step Out] from the [Run] menu, or click the [Step Out]
button in the toolbar.

¥

Figure 3.28 [Step Out] Button

g frterface — sort — SHT751 GPU board
JJ File Edit Aiew Bun Memory Setup Window Help |
a5 EN= R i L TR
s wmeR||) B0 [FEBELBPre 7]
s QEEDER. RER [BE(08 2 A
— e Watch Window
@ Line |&ddress |BP Label Source - £
o || g 0c000000 _main \inid main(void) _a[D] 6inﬂxaff?ffd4 !
G .
fa 10 long al10]; (1] D 3448
- long |3 %g% B,Egég
s }g int i, min, max; [4] D:lElEE
@ Il1s  ocooo004 For( 105 1<10; i++ )] [5] ~ D]16045
& ([15  ncoonooe I = rand(); (6] Dl1G3zy
s ocooooic if (< 01 [71 D1a74]
017 0cooonzo [N [8] ~Dj21463
E 19 } [9] D,EEH?
gz |12 0e000024 alil = max D70
20
— 21 0c00004) ®  Break sort(al;
= 22 (000050 min = all];
23 Jcoonne4 max = a[9];
B (|24  0coonoss min = 0;
B |l] 25 0z00005c max = 0;
= 26 0000060 changela);
27 (000070 min = al9];
28 Jcoonn74 max = al[0];
28 lcOO0078 1 =
4] H o4
4] | B
|F0r Help, pres= F1 | l_l_ S

Figure 3.29 [Program] Window (Step Out)

» The values of arrag is sorted in ascending order.
» To execute two steps, ustep In] twice.
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» The value ofmaxdisplayed in the [Watch Window§indow is changed to the maximum data
value.

CPU board

JJ File Edit Yiew Bun Memory Setup Windaw Help ‘
[ smewm || cany Rt .wPtas |2
|| = g PRENEBE.WER||8Me0e z @A N
? ; e Wiatch Window o x| I
Line |&ddress [BP |Label Source - el ﬁalue
W || s OcOO0000 _main \{ruid mainf{void) _a[IJ] _i Oxaffiffd4 }
Ak :
10 lanz al10]; %H B’gﬁﬁ
A long 1 [3] 0’3988
1z int i, min, max; (4] D’12197
13 ,
# Il14  ocooooos For( i=0; i<10; i++ ) 51 Dligoas
ﬁF 15 DCDDDDDC J = rand(): [?] D,]g_ll‘4]
oy 16 0cO00001e ifli <0 (8] 0’21468
ﬁ" }g OcOoooozo | jo=-is (8] 0°22117
w12 ocooooza alil = J; wax D722l
20 !
— || 21 0c0O0040 @ sort (a);
B |l] 22 0cO00050 min = al[l];
= 23 0c000054 max = al[89];
24 0cO00058 min = 0;
25 OcO0005c: max = 0;
|26 0c000060 changel(al;
27 OcO00070 min = a[9];
28 OcOO0074 max = al0];
24 OcO00074 1 &
Ki v
|Break = Step [ '_ &

Figure 3.30 [Program] Window (Step In—> Step In)
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3.13.3 Executing [Step Over] Command

The[Step Over] executes a function call as a single step and stops at the next statement of the main
program.

» Using [Step In], execute two steps to reachcti@nge function statement.

» To step through all statements in tienge function at a single step, select [Step Over] from the
[Run] menu, or click the [Step Over] button in the toolbar.

P
Figure 3.31 [Step Over] Button
g fmterface — sort — SHTTS1 GPU board
File Edit View Bun Memory Setup Window Help
ISR N 9, % |||E7 ELEL EE L B TR ?
M o E g B B, WEE (|l Bj0 8 2 @A M
& _i,, to . ozl
Line [Address |BP Lahel Source - Nane Walue
o ||| 2 fc000000 _main void main(void) _a[D] 6inﬂxaff?ffd4 !
da |9 . [1]  D’3488
A 1S ong 5500 RN
& }g int i, min, max; [4] D:IZIEQ
& Il14  ocooo004 Far( i=05 <103 i++ )] [5]  D716045
& |[15  Dcoonone i = rand(); (6] D716821
16 0c00001c o< 0] (7] D18741
4117 ocoonozo IR (8] D’21460
[ 1 = =13 [
E 18 } [9] D,'Z'ZII?
19 0c000024 } alil = j: max D70
20
21 0c000040 @ Break sort{al;
= 22 le000050 min = al0];
23 0cO00054 max = al9];
B (|lz4 ocoo0058 min = 0;
; 25 0c00005¢c max = 0;
26 0c000060 change(al;
27 0c000070 min = a[4];
28 0c000074 max = al0];
29 (000078 1 hd
ki v
Kl | B
Break = Step

Figure 3.32 [Program] Window (Before Step Over Execution)
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/ 751 GPU board
File Edit View Bun Memory Setup Window Help |
T YR E T T
|| & QRENEE. RER||2EL/0e 2 8a H
o Line |Address |BP Label Source - £
||| 8 0000000 _main woid main(void) =1
i 9 %D% Dz
g . 1 021468
& 1Y long all]; [2]  D’1974]
1 lone 15 [3] D’16827
& }g int i, min, max; [4] D:IBD45
& Il1a  ocooooos Far( i=05 i<10; i++ ) [5] Dl12122
& Il15  ocoooone j = rand(); [6] Dja96s
16 0c00001c iF0 < 0] (7] Dj8410
) [ [8] 073448
% (117 ocoonozo i= e :
G (10 ] (al 00
g |12 penoonz4 alil = i3 max D70
20 1
— |1 0cO00040 ®  Break sart(al;
= 22 le000050 min = al0];
23 0000054 max = a[9];
BB (24  0co0005R min = 0;
i 25 0e00005c max = 0;
26 0000060 changela);
27 fe000070 min = a[4];
28 0c000074 max = al0];
29 (000078 1 hd
KI o
[« | N
|For Help. press F1 [ l_ 4

Figure 3.33 [Program] Window (Step Over)

When the last statement of tbleange function is executed, the datas of arsayvhich is displayed
in the [Watch Window] window, is sorted in descending order.
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3.14  Displaying Local Variables

The user can display local variables in a function using the [Loeaisw. For example, we will
examine the local variables in thmain function, which declares five local variablesj , i , min,
andmax.

» Select [Locals] from the [View] menu. The [Locals] window is displayed.
If no local variable exists, none is displayed on the [Locals] window.
e Select [Step In] from the [Run] menu to execute another step.

The local variables and the corresponding values are displayed in the [Locals] window.

.« Locals

Figure 3.34 [Locals] Window

» Double-click the + symbol in front of arrayin the [Locals] window to display the elements of
arraya.

» When the elements of the arrayare referenced before and after executingtite function in
the program, the random data should be sorted in descending order. This confirms that the program
is operating normally.
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3.15 Software Break Function

The CPU board has software break function. With the HDI, a software breakpoint can be set using the
[Breakpoints] window. The CPU board can set up to 255 software breakpoints.

Setting a software breakpoint is described below.

» Select [Breakpoints] from the [View] menu. The [Breakpoints] window is displayed.

* Right-click in the [Breakpoints] window to open a pop-up menu, and select the [Del All] button to
cancel all the breakpoints that have been set. A dialog box will prompt you to confirm the deletion
of breakpoints. Click [Yes] to delete the breakpoints.

Breakpointz

Enable |File/Line svmhol |Address [Twype

Figure 3.35 [Breakpoints] Window (Before setting software break)
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Right-click in the [Breakpoints] window to open a pop-up menu, and select [Add].
The [Add/Edit Breakpoint] dialog box is displayed. Either an address or a symbol can be entered.

» Enterchange and check the [Enable] checkbox.

#dd#Edit Breakpoint

Breakpaint

change

¥ Enatle Cancel

Figure 3.36 [Add/Edit Breakpoint] Dialog Box
» Click the [OK] button.

The software breakpoint that has been set is displayed in the [Breakpoints] window.

Enable |File/Line [Svmbol [Address [Twpe
Sort .c/Bh _change 0CO001468 PC hreakpoint

< | i

Figure 3.37 [Breakpoints] Window (Software Breakpoint Setting)
To stop the tutorial program at the breakpoint, the following procedure must be executed:

» Close the [Breakpoints] window.

» Set the program counter and stack pointer values that have been set in section 3.8, Setting
Registers, (PC = H'0C000000, R15 = H'AFF80000) in the [Registers] window. Click the [Go]
button.

The program runs, and stops at the set breakpoint.

Rev. 1.0, 09/00, page 51 of 138
RENESAS



m Sartc

Line [#ddress |BP [Label
51 Oc0001Ze
s

53 Oc00071 40
b4

hh OcO00146 @
hh

57

54

54

1] Oc0001 43
b1 OcO00152
i

K] OcO00174
b4 Oc0001¥e
65

] 00001422

4

|Source -]

gap = gap/?;

!

_change wvoid change(long *a)

long tmp[10];
int i:

for(i=0; i<10; i++)1

| tnpli] = alil;
far(i=0; i<10; i++)1 _J
! alil = tnpld - il

} o

Figure 3.38 [Program] Window at Execution Stop (Software Break)

Select [Status] from the [View] menu. The [System Status] window displays the following contents.
The window confirms that execution was stopped at a breakpoint.

Syztem Status

[ten

Connected tao

CPU

Mode

Cache Status [C/0C
MU Status

[/0 definitian
Clock

Tarzet DLL Yersian
Manitor Yersiaon
Run Status

Break Cause

Run Time Count
Comm port baudrate

[Status

SH4 Wonitar

GHT751 Big Endian

Privilegzed Mode

OFF/OFF

OFF

SHTTEI

CPU: 167 MHz, External Bus: 83.5 MWHz
BLELHEE (nmodd vyvy)

BLORE

Break

Breakpaint

Ok Omin ls Oms 0.0us
RTE00 hit/s

session » Platform £ Memory £ Events / |

Figure 3.39 Displayed Contents of the [System Status] Window (Software Break)
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3.16 Run Time Count Function

By enabling the run time count function and executing the user program, the user program run time
can be measured. In the following example, the run time afdhte function is measured.

» Select [Delete All] from the pop-up menu in the [Breakpoints] window, and double-click the [BP]
column on the 21st and 22nd lines in the [Program] window to set breakpoints.

» Set the program counter and stack pointer values that have been set in section 3.8, Setting
Registers, (PC = H'0C000000, R15 = H'AFF80000) in the [Registers] window. Click the [Go]
button.

The program runs and stops at the breakpoint.

Line |&ddress |BP [Lahel |Source -]
a 0c000000 _main Enid mainivoid)

g

10 long al10];

11 long J;

1% int i, min, max;

13

14 OcO00004 fnr( i=0; i<10; i++ )

15 0c00000c = rand(),

16 0c00001: fli <001

17 0000020 = -l b
18 1

19 0c0000Z 4 alil = Js

20 i

21 O0c0O0040 ®  Break sart (a);

27 O0cO00050 @ Break min = al0];

23 0000054 max = al9];

24 0000058 min = 03

25 O0c00005¢ max = [;

7B 0c0000B0 changeial;

27 0000070 min = al89];

28 OcO0007 4 max = al0];

29 0000078 1 -
4 3

Figure 3.40 [Program] Window (Break before Run Time Count)

» Select [Status] from the [View] menu. The [System Status] window will appear.
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Syetem Status

Iten

Connected to

|

Mode

Cache Status IC/0C
MU Status

I/0 definition
Clock

Target DLL Yersion
Manitor Yersion
Run Status

Break Cause

Run Time Count
Comm part haudrate

[Status

oH4 Monitor

SHTI51 Big Endian

Frivileged Mode

OFF /OFF

OFF

SHTT51

CPU: 167 MHz, External Bus: 83.5 MHz
Aok ERE (nmodd wwwy)

HoRE

Break

Breakpoint

Dh Omin Os Ons 0.0us
ETE00 bit/s

Session s Platform { Memory £ Events / |

Figure 3.41 [System Status] Window (Run Time Count Disabled)

The time taken from the start of the program to the break is shown RariiEme Count on the
[Platform] sheet in the [System Status] window. In this example, the run time count function has not
been enabled, "Oh Omin 0s Oms 0.0us" is displayed.

» Select [Run Time...] from the [View] menu. The [Run Time Count Condition] dialog box will
appear.

» Check the [Enable] check button, select a measurement unit from [Measurement Mode], and click
the [OK] button. In this example, 0.10us (Max 6min50s) is selected.

Fun Time Count Condition

Internal clock: 41.75 MHz
¥ iEnable!

Meazurement Mode
% 0.10us (Max Gminb0s
£ Ddus Max 27mind
™ 15us Max Th4Smin)
™ flug Max Th1Smin

(0] 4 | Cancel |

Figure 3.42 [Run Time Count Condition] Dialog Box

The items listed in table 3.6 can be set in the [Run Time Count Condition] dialog box. The run time
can be checked in the [System Status] window.
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Table 3.6  Items Set in [Run Time Count Condition] Dialog Box

Item Description

Enable Check this box to enable the run time count function. The default
setting is "disable".

Measurement Mode Select a measurement unit here.

The selectable measurement units depend on the jumper setting (J23: bus frequency setting) on the
CPU board as shown in table 3.7.

Table 3.7 Selectable Measurement Units

J23 Internal Peripheral Measurement

Setting Module Operating Clock Unit Maximum Measurable Time

Closed 27.83 MHz 0.15 ps Approximately 10 minutes
0.6 us Approximately 41 minutes
2.3 s Approximately 2 hours 45 minutes
9.2 us Approximately 11 hours

Open 41.75 MHz 0.10 ps Approximately 6 minutes 50 seconds
0.4 us Approximately 27 minutes
1.5pus Approximately 1 hour 45 minutes
6.1 us Approximately 7 hours 15 minutes

» Click the [OK] button to enable the run time count function.
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» Click the [Go] button. Execution will stop at the line following #@t function, and the run
time will be displayed in a message box.

=— =zort - SH?751 GPU board - [Sorte]

JJE File Edit “iew PBun Memory Setup Window Help _|E‘|5||

o mm@m||»ean s

|ERERERER e R[N

) B 1) [l oF e (= W 860 8 e @A 1

—|Line [&ddress |BF [Label [Source
o || 5 OeDOO0DD _main \Enid main(vaid)
a9
H 10 long al10];
o | 11 long j;
& IE Y ! -t '3.}{,
13
#0114  0c000004 . D; i++
& 15 0c00000: Oh Omin Oz Oms 194 6us ),
_ || 18 0cO0001c I
w17 0cO0000Z20 : i
i IF ali]
19 0cO00002 4 alil = i
& | op
B | 21 0000040 @ sort{a);
_ 2z 0000050 @ min = al0];
—| 23 OcO00054 max = al[d];
B |24  0c000DS8 min = 03
== 2h NcO0n0ae max = [;
: 2h 0eDO00BD change (a);
77 0c000070 min = a[8];
28 0000074 max = al0l; _I;I
4 | 5

|E|reak = Breakpoint

| P4

Figure 3.43 [Program] Window (Stopped at a Breakpoint after Run Time Count)

The time from thesort function call to the return to the caller can be check&latTime
Count on the [Platform] sheet in the [System Status] window.
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Svstem Status

[ten

Connected to

CPU

Maode

Cache Status IG/00
MM Status

[/0 definition
Clack

Target DLL Yersian
Monitor Yersion
Run Status

Break Cause

Run Time Count
Comm port baudrate

[Status

SH4 Manitar

sH?751 Big Endian
Privilezed Mode

OFFAOFF

OFF

SHTITE

GPU: 16T MHz, External Bus:
BLORLEEE (nmodd owywy)

nLORE

Break
Breakpoint

Oh Omin ls
RTE00 hit/s

B3.5 MHz

Oms 1494.0us

Session b Platform £ Memory A Evenis /

Figure 3.44 [System Status] Window (Run Time Count Result)

Notes: 1. The run time will vary depending on the execution environment.

2. The run time can be measured by executing with [Go] but cannot be measured by [Step In],

[Step Out], or [Step Overl.
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3.17 Saving a Session

If a program has been downloaded, the corresponding source file is displayed, and numerous windows
are opened, it can take some time to restore this setup the next time the program is downloaded. The
HDI is able to save the current settings for retrieval the next time the program is loaded, in order to
reduce setup time.

In order to save a session which has already been named, or to save the session with the same name as
the current object file, select [Save Session] from the [File] menu.

To save the current settings as a session with a new name, select the [Save Session As...] command
from the [File] menu. A dialog box is displayed; enter the new name for the session. Three files are
saved: the HDI session file (*.hds), the target session file (*.hdt), and the watch session file (*.hdw).

The target session file stores the following information:

» Software breakpoint information
* |/O definition file information
* Run time count function information

Note: No symbol or memory information is saved in the session files. If changes are to be used again
in future, they must be saved separately. For details, refer to the Hitachi Debugging Interface
User's Manual.
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3.18 What Next?

In this tutorial, we have introduced as examples program debugging using the CPU board and the
HDI.

Further details on the use of the HDI can be found in the Hitachi Debugging Interface User's Manual
available in the supplied CD-R.
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Section 4 Descriptions of Windows

4.1 HDI Windows
HDI window menu bars and the corresponding pull-down menus are listed in table 4.1.

A O mark and/or the relevant section number is shown in the table when menu description is included
in the Hitachi Debugging Interface User's Manual or in this manual.

Menu items shown in gray on the screen are not available.

Table 4.1 HDI Window Menus and Related Manual Entries

Hitachi Debugging
Interface
Menu Bar Pull-Down Menu User's Manual This Manual

File Menu New Session...

Load Session...

Save Session

3.17
3.6.1

Save Session As...

Load Program...

Initialize
Exit
Edit Menu Cut
Copy
Paste
Find...

Evaluate...

O/ 0/0 000000000
I
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Table 4.1 HDI Window Menus and Related Manual Entries (cont)
Hitachi Debugging
Interface
Menu Bar  Pull-Down Menu User's Manual This Manual
View Menu  Breakpoints (@) 3.10, 3.15,4.2.2
Command Line ™ O —
Disassembly... o —
I/O Area O —
Labels o —
Locals O 3.14
Memory... o 3.11
Performance Analysis™ O —
Profile-List™ o —
Profile-Tree™ O —
Registers o 3.8
Source... O 3.6.2
Status (@) 39,424
Trace™ O —
Watch o —
Cache Control... — 4.2.6
Run Time... — 3.16,4.2.5
Localized Dump O —
Simulated /O Window o 4.2.7
Run Menu Reset CPU *® O —
Go 0] 3.9
Reset Go *° O —
Go to Cursor o —
Set PC To Cursor O —
Run... o —
Step In O 3.13.1
Step Over o 3.13.3
Step Out O 3.13.2
Step... o —
Halt O —
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Table 4.1

Menu Bar

Pull-Down Menu

Hitachi Debugging
Interface
User's Manual

HDI Window Menus and Related Manual Entries (cont)

This Manual

Memory Menu

Refresh

O

Load...

Save...

Verify...

Test...

Fill...

Copy...

Compare...

Configure Map...”

Configure Overlay...”

Setup Menu

Status bar

Options...

Radix

Customise

Configure Platform...

Window Menu

Cascade

Tile

Arrange Icons

Close All

Help Menu

Index

Using Help

Search for Help on

About HDI

000 0000000000000 o00oo0o0o0o0o

Notes: 1. Function not supported.

ok, wbd

RENESAS

Only CPU board ROM and RAM information display is supported.

User program is executed after setting PC to H'AC000000.

Function for test use. Correct operation cannot be guaranteed.

PC, SR, and VBR are initialized. The reset signal is not sent to the CPU.
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4.2 Descriptions of Each Window

This section describes each window.

421 [Monitor Setup] Dialog Box
Function:

Specifies the setup conditions for the CPU board. This dialog can be displayed by selecting [Configure
Platform...] from the [Setup] menu.

Window:

Monitor Setup

— Target Monitor Comme S ettings
COM1:

ErEa
Baud Fate: |-|-|52|:||:| vI Help

10 definition file: ISH??E'] Browse. ..

I Downlaad with werify

]S

Comms Part;

[ el

[ Delete breakpointz when program is reloaded

[ Beset CPU when program has been downloaded

Figure 4.1 [Monitor Setup] Dialog Box

Notes: 1. The I/O register definition file can be selected in this dialog box. Be sure to select a file
within the HDI installation directory. Otherwise, the 1/O register window will not operate
correctly.

2. The name of the I/O register definition file can consist of up to nine characters. This
number does not include the file name's extension.
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Description:
The settings of the [Monitor Setup] dialog box are indicated below.

Table 4.2  [Monitor Setup] Dialog Box Page

Option Setting

Comms Port: COM1, COM2, COMS3, or COM4 can be selected as the host
computer serial port.

Baud Rate: Sets the serial baud rate. Select either 57600 bit/s or 115200 bit/s,

to match the setting of jumper J36. Connection is not possible at
any other setting.

1/0O definition file Sets the I/O register definition file. Click the [Browse] button to
select the SH7751 definition file. When selecting a file, the [I/O
Registers] window (accessed from the [View] menu) can be used to
display register information.

Download with verify The CPU board does not support this function (this box cannot be
selected).

Delete breakpoints when  When this box is checked, all breakpoints are deleted when a
program is reloaded program is reloaded.

Reset CPU when program When this box is checked, registers are initialized* when a program
has been downloaded is loaded. No reset signal is input to the CPU board.

Note: Initialized as follows: PC = H'AC000000, SR = H'600000EO, and VBR = H'A0080000 (big
endian) or H'A0100000 (little endian).

Clicking the [OK] button sets the setup conditions. If the [Cancel] button is clicked, this dialog box is
closed without setting the conditions.
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4.2.2  [Breakpoints] Window

Function:

This window lists all break conditions that have been set. This window can be displayed by selecting
[Breakpoints] on the [View] menu.

Window:

Breakpointz

Enable [FileflLine |Symbol  [Address |Twpe
Sort.c/55 _change 0CO00146 PC breakpoint

Figure 4.2 [Breakpoints] Window
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Description:

The [Breakpoints] window displays breakpoint setting information. The items listed in table 4.3 are
displayed.

Table 4.3  [Breakpoints] Window Display Items

Item Description

[Enable] Displays whether the break condition is enabled or disabled. The “” indicates that
the breakpoint is enabled.

[File/Line] Displays the file name and line number where the breakpoint is set.

[Symbol] Displays the symbol corresponding to the breakpoint address. If no symbol has
been defined for the address, a blank is displayed.

[Address] Displays the address where the breakpoint is set.

[Type] Displays “PC breakpoint”

Right-clicking in the [Breakpoints] window will open a pop-up menu, through which breakpoints can
be set, changed, deleted, enabled, or disabled. The pop-up menu functions are described in table 4.4.

Table 4.4  [Breakpoints] Window Pop-up Menu Operation

Menu Description

[Add] Sets break conditions. Selecting this menu will display the [Add/Edit
Breakpoint] dialog box, enabling break conditions to be set.

[Edit] Changes break conditions. Select break conditions to be changed and
select this menu. The [Add/Edit Breakpoint] dialog box will be displayed,
enabling the break condition to be changed.

[Disable] Enables or disables break conditions. Select break conditions to be

([Enable]) enabled or disabled and select this menu.

[Delete] Clears break conditions. Select break conditions to be cleared and select
this menu.

[Del All] Clears all break conditions.

[Go to Source] Jumps to the break address in the [Source] window.
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4.2.3 [Add/Edit Breakpoint] Dialog Box

Function:

Sets a breakpoint. This dialog box is displayed when the [Add] or [Edit] is selected in the pop-up

menu in the [Breakpoints] window, which is displayed by selecting the [Breakpoints] item on the
[View] menu.

Window:
Add/Edit Breakpoint %]
Breakpoint addrezs
[Foros
I+ Enable ﬂl
Figure 4.3 [Add/Edit Breakpoint] Dialog Box
Description:

The [Add/Edit Breakpoint] dialog box is made up of the components listed in the table below.

Table 4.5 [Add/Edit Breakpoint] Dialog Box Items

Item Description
[Breakpoint address] Enter the address or symbol for which a breakpoint is to be set.
[Enable] The breakpoint is enabled when this box is checked.

After clicking [OK], the breakpoint is set.
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424 [System Status] Window
Function:

This window lists information, such as conditions that have been set to the CPU board and execution
results. It is displayed by selecting the [Status] item on the [View] menu.

Window:
Syztem Status
[ten [Status
Connected tao SH4 Wonitar
CPU GHT751 Big Endian
Maode Privileged Mode
Cache Status [C/0C OFF/OFF
MU Status OFF
[/0 definitian SHTTET
Clock CPU: 167 MHz, External Bus: 83.5 MWHz
Tarzet DLL Yersian B REE Cnm o dd owywy)
Manitor Yersiaon hoRE
Run Status Break
Break Cause Breakpaint
Run Time Count Ok Omin ls Oms 0.0us
Comm port baudrate RTE00 hit/s
session » Platform £ Memory £ Events /

Figure 4.4 [System Status] Window
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Description:

The items listed in the following table are displayed in the [System Status] window.

Table 4.6  [System Status] Window Display Items
Sheet Item Description
[Session] Target System Indicates whether the CPU board is connected or not.
Session Name Displays the session file name.
Program Name Displays the load module file name.
[Platform] Connected to Displays the name of the connected CPU board
monitor program.
CPU Displays the target CPU and endian setting.
Mode Displays the CPU processor mode (privileged mode or
user mode).
Cache Status IC/OC Shows whether the cache is enabled or disabled.
MMU Status Shows whether the MMU is enabled or disabled.
I/O definition Displays the selected I/O register definition file.
Clock Displays the clock frequency (CPU operating frequency
and external bus frequency) being used.
Target DLL Version Indicates the version of the target DLL for connection to
the CPU board.
Monitor Version Displays the monitor program version.
Run Status Displays the user program execution status:
Run: Being executed
Break: Stopped
Break Cause Displays the cause of the program stopping at break.
Run Time Count Shows the time from the start of the user program to
the break. When the run time count function is
disabled, "0Oh Omin Os Oms 0.0us" is displayed.
Comm port baudrate Indicates the data baud rate for the serial interface.
[Memory] Target Device Configuration  Not supported by this CPU board.
System Memory Resources Not supported by this CPU board.
Loaded Memory Areas Shows the area where the load module is loaded.
[Events] Resources Shows the number of breakpoints set.
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4.2.5 [Run Time Count Condition] Dialog Box
Function:

Specifies the condition for measuring the run time. It is displayed by selecting [Run Time...] from the
[View] menu.

Window:

Furn Time Count Condition

Internal clock: 4175 MHz
v :
— Meazurement Mode

& 010us tMax GminG0s)
 D4us (Max 27 mind

= 1.5uz (Max 1h4Smin?
 Blus (Max TH1Smind

] 4 I Cancel |

Figure 4.5 [Run Time Count Condition] Window
Description:

The items listed in table 4.7 can be set in the [Run Time Count Condition] dialog box. The run time
can be checked in a message box displayed at break or in the [System Status] window.

Table 4.7  [Run Time Count Condition] Dialog Box Items

Item Description

Enable Check this box to enable the run time count function. The default
setting is "disable".

Measurement Mode Select a measurement unit here.

The setting is stored when the [OK] button is clicked.

The selectable measurement units depend on the jumper setting (J23: bus frequency setting) on the
CPU board as shown in table 4.8.
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Table 4.8 Selectable Measurement Units

J23 Internal Peripheral Measurement

Setting Module Operating Clock Unit Maximum Measurable Time

Closed 27.83 MHz 0.15 ps Approximately 10 minutes
0.6 us Approximately 41 minutes
2.3 s Approximately 2 hours 45 minutes
9.2 us Approximately 11 hours

Open 41.75 MHz 0.10 ps Approximately 6 minutes 50 seconds
0.4 us Approximately 27 minutes
1.5pus Approximately 1 hour 45 minutes
6.1 us Approximately 7 hours 15 minutes

Note: When the maximum measurable time shown in table 4.8 is exceeded, the measured value will

be invalid.

4.2.6 [Cache Control] Dialog Box

Function:

Specifies the cache functions. This dialog is displayed on selecting [Cache Control...] from the [View]

menu.

Window:

Cache Control

Ihstruction CGache

 Enabl

[~ Ihstruction Cache Flush

Operand Cache

£ Enable [~ Operand Cache Flush
+ Dizable
P1 Area write mode POUOPS Area write mode

& YWirite Throueh

" WWrite Through

" Wikite Back * ‘Write Back
Cancel |

Figure 4.6 [Cache Control] Dialog Box
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Description:

The items listed in table 4.9 are displayed and set in the [Cache Control] dialog box. The cache control
register settings are displayed when the dialog box is opened. When the [OK] button is clicked, the
settings are sent to the cache control registers.

Operation can be specified separately for the instruction cache and operand cache.

Table 4.9 [Cache Control] Dialog Box Items

Item Description

Instruction Cache Enables or disables the instruction cache. Check the [Instruction Cache
Flush] check box then click the [OK] button to flush all entries from the
instruction cache.

Operand Cache Enables or disables the operand cache. Check the [Operand Cache Flush]
check box then click the [OK] button to flush all entries from the operand
cache.

P1 Area write mode Specifies the operating mode (write-through or write-back) for the P1 area.

PO,U0,P3 Area Specifies the operating mode (write-through or write-back) for the PO, U0,
write mode and P3 areas.

4.2.7 [Simulated 1/0O Window] Window
Function:

This window displays data input to or output from the serial line during user program execution. It is
valid only during execution of a user program. Serial data output by the user program is displayed in
this window.

» Data input from the keyboard of the host computer is displayed in this window in addition to being
sent to the CPU board.

This window is displayed on selecting the [Simulated 1/0O Window] item from the [View] menu.
Right-clicking the mouse on this window displays the following pop-up menu.
[Copy] Copies the text appearing in highlighted to the Windowkpboard.

[Paste] Pastes the contents of the Winddwsipboard to the [Simulated I/O Window], and
sends the same contents to the CPU board.

[Clear Window] Clears the contents of the [Simulated I/O Window] window.
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Window:

B Simulated IO Window

Test Start.

> ABCDEFGHIJKLMM. ..
ABCOEFGHIJKLMN. . .

> 12345
12345

>><:><i

Figure 4.7 [Simulated 1/0O Window] Window

The above is the window displayed when the sample program supplied with this CPU board is used.
For details on the sample program, refer to section 7.3, Sample Program.

Note: When using the [Simulated I/O Window] window, an interrupt handler must be prepared in
the user program. For details on the interrupt handler, refer to section 7, Creation of User
Interrupt Handler.

4.2.8 [Command Line] Window

The SH7751 CPU board does not guarantee the [Command Line] window operation; do not use the
[Command Line] window.
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Section 5 CPU Board Specifications

5.1 Block Diagram

A block diagram of the CPU board is shown in figure 5.1.

SH bus
F I3 T 1
SH7751 FLASH Expansion -
32 Mbytes | | bus ISA interfacq | 91C96 | |pg FpGA|| EPROM
U ) interface TXOMAC
[ Timer 0] [MMU INTC [ssc |« > SDRAM Trans
Timer 1] [Cache J[_DMAC I_l 64 Mbytes [RXDMAC ]
W Ao e PLL
70 port] [[CMT, DMAC _|
H-0DT] (SCI0_JCDMAC 3 ]| Pcic
AUD SCIE2 t PCl bus
L I_l Compact PCI
y connector User expansion
Driver Driver
oA board Maser
connector Compact PClI bus )
(Micro-ribbon)| Debug'Serial Produ&t Serial P
Port Port

Figure 5.1 Block Diagram of the CPU board
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5.2 Specifications

Table 5.1 lists the components of the CPU board.

Table 5.1  External Specifications

Item

Specifications

Microcomputer
(V1)

SH7751 Type name: HD6417751F167
Package: 256-pin QFP

Operating frequency

CPU internal clock: 167 MHz
Bus clock: 83.5 or 55.7 MHz (switchover by jumpers)

Endian Little or big endian (switchover by jumpers)
Memory RAM SDRAM Capacity: 64 Mbytes
(M1, M2) Bus width: 32 bits
Type number: HM5225165TT-A60 x 2
ROM EPROM (only the socket is Capacity: 512 kbytes
(M7) mounted) Bus width: 16 bits
Type number: HN27C4096A x 1
ROM Flash memory (monitor Capacity: 32 Mbytes
(M3-M6)  program) Bus width: 32 bits

Type number: G28F640J5-150 x 4

Serial interface (CN15)

One channel: Conforms to RS-232C
Transfer rate: 57600 or 115200 bit/s (switchover by jumpers)
Connector: 9-pin D-sub connector

Connector on CPU board: DELC-J9PAF-20L9 manufactured by Japan
Aviation Electronics Industry, Ltd.

Cable length: 1.5 m (use the supplied cable)

LAN interface (CN2)

One channel: 10BASE-T
Transfer rate: 10 Mbit/s max.

Controller: LAN91C96 manufactured by Standard Microsystems
Corporation

Configuration ROM: M93C46 manufactured by STMicroelectronics

Connector on CPU board: NT10-8SAG-10L9 manufactured by Japan
Aviation Electronics Industry, Ltd.
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Table 5.1

Item

External Specifications (cont)

Specifications

User expansion board
interface (CN1)

Expansion board connector

Connector on CPU board: 53481-1809 manufactured by Molex
Incorporated.

Connector on user board: 52760-1809 manufactured by Molex
Incorporated.

Compact PCl interface
(CN19 and CN20)

System board conforming to PICMG2.0 rev. 2.1.
Only J1 and J2 connectors are mounted.

Interface voltage: 3.3V

PCI clock: 33 MHz

Data bus width: 32 bits

Supported expansion slots: Up to four slots

Interface connectors

J1 connector (CN19): 27-8071-110-011-833 manufactured by Kyocera
Elco Corporation

J2 connector (CN20): 27-8071-110-010-833 manufactured by Kyocera
Elco Corporation

E10A emulator interface
(CN23)

Connector on CPU board: DX20M-36S manufactured by Hirose Electric
Co., Ltd.

Switches SW1: Power supply switch
SW2: Manual reset switch
SW3: Power-on reset switch
SW4: Abort switch
External Board Width: 233.35 mm, Length: 160 mm
dimensions Product Width: 236 mm, Length: 175 mm, Height: 42 mm
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5.3

Memory Map

Memory map of the CPU board is shown in figure 5.2. Each area of the CPU is allocated as follows:

Area O:

Area 1.

Area 2:

Area 3:

Area 4.

Area 5:

Area 6:

Monitor program area. Allocated to flash memory. Bus width is 32 bits for flash memory.
However, when using the EPROM mode (J25 is closed), the bus width is set to 16 bits.

System register area. The LAN controller (LAN91C96) can be accessed in this area.

User expansion board interface area. The user expansion board can be allocated. Note that
when the EPROM mode is used (J25 is closed), flash memory is allocated to this area. In this
case, the user expansion board cannot be used in this area.

64Mbyte SDRAM is allocated. The first 63.5Mbyte area is assigned to the user area and the
remaining 0.5Mbyte area is assigned to the monitor program work area. Bus width is 32 bits
fixed.

User expansion board interface area. The user expansion board can be allocated.
User expansion board interface area. The user expansion board can be allocated.

User expansion board interface area. The user expansion board can be allocated.
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Physical
address Normal mode EPROM mode
------ H’0000 0000 Flash 32 Mbt TTemTTry H’0000 0000
ash memor es
CSo HOLFF FRFF Y ( ytes) EPROM (512 kbytes) H'007F FEFF
Flash memory expansion area R d
______ H'03FF FFFF (32 Mbytes) eserve H'03FF FFFF
H'0400 0000 System FPGA#1 System FPGA#1 H'0400 0000
Cs1 (Int Status, Int Mask) (Int Status, Int Mask)
H'0500 0000 Reserved Reserved H'0500 0000
H’0600 0000 System FPGA#2 0 System FPGA#2 H’0600 0000
H'0700 0000 (power control, NMI control) (power control, NMI control)
______ H'O7FEF FEFF Ethernet control Ethernet control H0700 0000
cso H’0800 0000 Flash memory (32 Mbytes) H'0800 0000
Expansion bus area (*1) Flash memory expansion area | H'09FF FFFF
______ H'OBFF FFFF e (32 Mbytes) )
H'0C00 0000 H'OBFF FFFF
cs3 SDRAM (64 Mbytes)
H'OFFF FFFF
""" H’1000 0000
CS4
Expansion bus area
------ H1400 6000
*
Cs5 Expansion bus area (*2) PCI memory space (*3)
...... H:17FF FFEF H’0000 0000
H1800 0000 . Expansion area
CS6 Expansion bus area (*2) 16 Mbytes
______ H'1BFF FFFF v
H11C00 0000 CPU hip 1/0 and control regist S C tb d
, on-chi and control registers annot be use
Control HI1CFEFEFF P 9 H'FFFF FFFF
Space H'1D00 0000 PCI memory space (16 Mbytes)
H'1DFF FEFF PCI I/O space (*3)
H'1E00 0000 PCl local registers
H1E23 FEFE J H'0000 0000 [Expansion area
PCI 1/O space (256 kbytes , 256 kbytes
H'1E27 FEFE pace ( ytes) H'0003 FFFE yt
; ; Cannot be used
CPU on-chip I/0 and control registers )
...... H'1FFF FFFF P 9 HFFFF FEFF

Figure 5.2 CPU Board Memory Map

Notes 1. When the EPROM mode is used, flash memory is allocated to area CS2. In this case, the
expansion bus area cannot be accessed.
2. Accesses to the CS5 and CS6 areas can be enabled or disabled by the setting of the
CS56EN bit of NMIMASK.
3. Address assignment to the PCI memory space and PCI I/O space in this CPU board can be
modified by setting the respective SH7751 registers.
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54 External Interface

541 Serial Interface

A\ WARNING

Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES or
CONNECTORS. Failure to do so will result in a FIRE HAZARD
and will damage the user system and the CPU board or will
result in PERSONAL INJURY. The USER PROGRAM will be
LOST.

The CPU board has a serial interface (1 channel) that conforms to RS-232C and can be used as an
interface with the host computer. This interface is implemented by using an on-chip serial
communication interface (SCIF: serial interface with FIFO) in the CPU. Therefore, when the user wants
to directly use the SCIF in the CPU, the user must create an interrupt handler and use the Simulated 1/O
window. For details, refer to section 7, Creation of User Interrupt Handlers. The connector is a 9-pin D-
sub connector, and the interface cable is supplied with the CPU board. A baud rate of 57600 bit/s or
115200 bit/s can be selected. To set the baud rate, refer to section 2.8, Jumpers.

Table 5.2 lists the pin assignment for the serial interface connector. Table 5.3 shows the serial interface
specifications. For details on serial interface cable connection, refer to section 2.4, Connecting Cables.

Table 5.2  Pin Assignment of the Serial Interface Connector

Pin No. Signal Name Description

1 Reserved No connection

2 RXD Received serial data

3 TXD Transmitted serial data

4 DTR Data terminal ready (connected to DSR on the board)
5 SG Signal ground

6 DSR Data set ready (connected to DTR on the board)

7 RTS Request to send

8 CTS Clear to send

9 Reserved No connection
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Table 5.3  Serial Inte

Item

rface Specifications

Specifications

Synchronization method

Asynchronous method

Transfer rate

57600 or 115200 bit/s (can be switched with jumpers)

Bit configuration

Start bit: 1 bit

Stop bit: 1 bit

Parity: None

Data length: 8 bits

Flow control: RTS/CTS control

Controller On-chip SCIF (serial communication interface with FIFO) in the SH7751
Driver LT1330CG (manufactured by LINEAR TECHNOLOGY CORP.)
Connector Connector on CPU board: DELC-J9PAF-20L9 manufactured by Japan

Aviation Electronics Industry, Ltd.

Figure 5.3 shows the wiring connection between the host computer (IBM PC compatible machine)
serial interface connector and the CPU board interface connector. Figure 5.4 shows the serial interface
connector pin arrangement. For details on serial interface cable connection, refer to section 2.4,

Connecting Cables.

IBM PC CPU board
Serial interface connector Serial interface connector
7 ) )
cp |10 O 1| N.C.
RXD [2 O >< O 2| RXD
XD |3 O O 3| TxD
DTR |4 O_ﬂ ﬁ_o 4] PTR== _: Pin 4 and pin 6 are
sG |50 >< O 5| sG ! directly connected
DSR |6 O O 6| DSR-——I on the CPU board.
RTS |7 C C 7| RrRTS
cTs |8 O >< O 8| cTs
RING |9 O O 9 N.C.
—/ —/

Figure 5.3 Connection to Host Computer
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Pin 1§ CN15 Pin 5

Pin 6 Pin 9

Figure 5.4 Serial Interface Connector Pin Arrangement

5.4.2 EPROM Socket Interface

A WARNING

Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES or
CONNECTORS. Failure to do so will result in a FIRE HAZARD
and will damage the user system and the CPU board or will
result in PERSONAL INJURY. The USER PROGRAM will be
LOST.

The CPU board has an EPROM socket (M7) for the HN27C4096, through which an ROM-ICE can be
connected to the CPU board. Close the J25 and turn on the power to start the CPU board in the
EPROM mode. The EPROM socket area is allocated to the 512 kbytes from the start address of area 0.
In the EPROM mode, the bus width of area 0 is set to 16 bits.

In this mode, the flash memory for monitor program is allocated to area 2. Table 5.4 lists the pin
assignment for the EPROM socket.
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Table 5.4  Pin Assignment of the EPROM Socket

Pin No. Signal Name Pin No. Signal Name Pin No. Signal Name Pin No. Signal Name

1 VPP 11 Vss 21 A0 31 A9

2 /CE 12 1107 22 Al 32 Al0
3 1/1015 13 1/06 23 A2 33 All
4 11014 14 1/05 24 A3 34 Al12
5 1/1013 15 1/04 25 A4 35 Al3
6 1/012 16 1103 26 A5 36 Al4
7 /1011 17 1/02 27 A6 37 Al5
8 1/010 18 /01 28 A7 38 Al6
9 1109 19 1/00 29 A8 39 Al7
10 1/08 20 /OE 30 Vss 40 Vce

Some types of ROM-ICE use the NMI and RESET signals of the CPU to implement debugging
functions. In this CPU board, these signals are assigned to TP56 and TP57.

TP56: Reset input; ORed with the logic on the board to create the _RESET signal for the
CPU.

TP57: NMI input; ORed with the logic on the board to create the _NMI signal for the
CPU. This input can be masked by using the on-board register NMIMASK.

5.4.3 LAN Interface

A WARNING

Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES or
CONNECTORS. Failure to do so will result in a FIRE HAZARD
and will damage the user system and the CPU board or will
result in PERSONAL INJURY. The USER PROGRAM will be
LOST.

The CPU board has one channel of LAN interface, to which the user application program can access.

The LAN91C96 LAN controller manufactured by Standard Microsystems Corporation is used to
support a 10BASE-T interface. The MAC address and configuration information are stored in the
EEPROM (M93C46 manufactured by STMicroelectronics) on the CPU board. Be careful not to
modify the contents of the EEPROM accidentally. The MAC address in the EEPROM is also
displayed on the board.
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Note that the monitor program of the CPU board does not include the LAN interface driver; the driver
software must be prepared as part of the user program to use the LAN interface. Tables 5.5 to 5.9 list
the register specifications of the LAN91C96 LAN controller. For details of the LAN controller, refer

to the documents released by Standard Microsystems Corporation.

Table 5.5 LAN91C96 LAN Controller Register Specifications (Bank 0)

Initial Access
BANKO Register Abbrev. R/W Value Address Size (bit)
Transmit control register TCR R/W 0XX0h 07000000 16
EPH status register EPHSR R 0000h 07000002 16
Receive control register RCR R/W 0000h 07000004 16
Counter register ECR R 0000h 07000006 16
Memory information register MIR R 1818h 07000008 16
Memory configuration register MCR R/W 3300h 0700000A 16
Bank select register BSR R/W 33XXh 0700000E 16

Table 5.6 LAN91C96 LAN Controller Register Specifications (Bank 1)

Initial Access
BANK1 Register Abbrev. R/W Value Address Size (bit)
Configuration register CR R/W XXXXh 07000000 16
Base address register BAR R 1867h 07000002 16
Individual address register IAR R/W XXXXh 07000004 16
Individual address register IAR R/W XXXXh 07000006 16
Individual address register IAR R/W XXXXh 07000008 16
General address register GPR R/W 0000h 0700000A 16
Control register CTR R/W 0XXXh 0700000C 16
Bank select register BSR R/W 33XXh 0700000E 16
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Table 5.7 LAN91C96 LAN Controller Register Specifications (Bank 2)

Initial Access
BANK?2 Register Abbrev. R/W Value Address Size (bit)
MMU command register MMUCR W 00h 07000000 8
Auto TX start register AUTOTX R/W 00h 07000001 8
Packet number register PNR R/W 00h 07000002 8
Allocation result register ARR R 80h 07000003 8
FIFO ports register FIFO R 8080h 07000004 16
Pointer register PTR R/W 0000h 07000006 16
Data register DATA R/W XXXXh 07000008 16
Data register DATA R/W XXXXh 0700000A 16
Interrupt status register IST R 03h 0700000C 8
Interrupt acknowledge register ACK W XXh 0700000C
Interrupt mask register MSK R/W 00h 0700000D 8
Bank select register BSR R/W 33XXh 0700000E 16

Table 5.8 LAN91C96 LAN Controller Register Specifications (Bank 3)

Initial Access

BANK3 Register Abbrev. R/W Value Address Size (bit)
Multicast table MT R/W 00h 07000000 16
Multicast table MT R/W 00h 07000001 16
Multicast table MT R/W 00h 07000002 16
Multicast table MT R/W 00h 07000003 16
Multicast table MT R/W 00h 07000004 16
Multicast table MT R/W 00h 07000005 16
Multicast table MT R/W 00h 07000006

Multicast table MT R/W 00h 07000007
Management interface MGMT R/W 3X30h 07000008 16
Revision register REV R 3340h 0700000A 16
Early RCV register ERCV R 331Fh 0700000C 16
Bank select register BSR R/W 33XXh 0700000E 16
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Table 5.9 LAN91C96 LAN Controller Register Specifications (Bank 4)

Initial Access
BANK4 Register Abbrev. R/W Value Address Size (bit)
Ethernet configuration option ECOR 40h 07000000 8
register
Ethernet configuration and status ECSR 00h 07000001 8
register
Bank select register BSR R/W 33XXh 0700000E 16

5.4.4 User Expansion Board Interface
The CPU board has a user expansion board interface connector for the user expansion board interface.

The maximum currents that can be supplied through the expansion board interface are shown below.
When designing a user expansion board, note that the following values must not be exceeded.

« 5.0Vsystem: 3.0A
e 3.3Vsystem: 1.2 A

A WARNING

Always switch OFF the CPU board and the user system
before connecting or disconnecting any CABLES or
CONNECTORS. Failure to do so will result in a FIRE HAZARD
and will damage the user system and the CPU board or will
result in PERSONAL INJURY. The USER PROGRAM will be
LOST.

Figure 5.5 shows the pin arrangement of user expansion board interface connector CN1. Table 5.10 lists
the pin assignment of the user expansion board connector CN1. Refer to the CPU hardware manual for
those pins that have no numbers in the pin function column. The pin signal level is 3.3 V, which is
equivalent to that of the SH7751 CPU. For details on expansion board connection, refer to section 2.4,
Connecting the User Expansion Board.
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Pin 1 Pin 90
CN1 (top view) /

7 ~
\

Board end

Pin 180

Figure 5.5 User Expansion Board Interface Connector CN1 Pin Arrangement
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Table 5.10 Pin Assignment of User Expansion Board Interface Connector CN1

Pin  Pin Pin Pin  Pin Pin Pin  Pin Pin
No. Name Function No. Name Function No. Name Function
1 +5V 31 GND 61 GND

2 GND 32 A20 2 62 D19 1)
3 +12v 33 A21 2) 63 D20 1)
4  GND 34 A22 2) 64 D21 (1)
5  +1.8V 35 A23 2) 65 D22 €))
6 GND 36 A24 2 66 D23 1)
7 GND 37 GND 67 GND

8 A0 2 38 A25 2 68 D24 1)
9 Al 2 39 DO (1) 69 D25 (1)
10 A2 ) 40 D1 (1) 70 D26 (1)
11 A3 2) 41 D2 (1) 71 D27 (1)
12 A ) 42 D3 (1) 72 D28 (1)
13 GND 43 GND 73 GND

14 A5 ) 44 D4 (1) 74 D29 (1)
15 A6 2) 45 D5 (1) 75 D30 (1)
16 A7 ) 46 D6 (1) 76 D31 (1)
17 A8 2) 47 D7 (1) 77  STATUSO

18 A9 ) 48 D8 ) 78  STATUS1

19 GND 49 GND 79 GND

20 A10 2 50 D9 1) 80 GND

21 A1l 2) 51 D10 (1) 81 B_CKIO (12)
22 Al2 ) 52 D11 (1) 82 GND

23 A13 2) 53 D12 (1) 83 CKIO (12)
24  Al4 ) 54 D13 (1) 84 GND

25 GND 55 GND 85 +5V

26 Al5 ) 56 D14 (1) 86 GND

27 A16 2 57 D15 1) 87  +12V

28 Al7 ) 58 D16 (1) 88 GND

29 A18 2 59 D17 1) 89  +1.8V

30 A19 2 60 D18 1) 90 GND
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Table 5.10 Pin Assignment of Expansion Connector CN1 (cont)

Pin  Pin Pin Pin  Pin Pin Pin  Pin Pin
No. Name Function No. Name Function No. Name Function
91 +5V 121 +3.3V 151 EBREQOA# (10)
92 GND 122 IRL2# (7) 152 EBREQOB# (10)
93 +12V 123 TCK (6) 153 TCLK

94 GND 124 TMS (6) 154 STBY#

95 +1.8Vv 125 +3.3V 155 FLRDY

96 GND 126 TDO (6) 156 RXD2 (5)
97 +3.3V 127 ASEBREAK# (6) 157 +3.3V

98 WEO# 128 CSO# 158 Mode5

99 WE1# 129 CSi# 159 CTS2 (5)
100 WE2# 130 CS2# 160 +3.3V

101 WE3# 131 CS4# 161 RD#

102 BS# 132 CS5# 162 RDWR#

103 RXDO 133 +3.3V 163 IRLO#

104 TXD2 (5) 134 EBACK2# (10) 164 IRL1#

105 +3.3V 135 CS6# 165 IRL3#

106 TRST# (6) 136 CE2A# 166 RDY 9)
107 101S16 137 BREQ# (4) 167 MRESET# (8)
108 SCK2 138 DRAKO 168 RESET# (8)
109 +3.3V 139 DREQO# 169 +3.3V

110 CS3# (11) 140 +3.3V 170  +3.3V

111 RTS2 (5) 141 DACKO 171 NMI# (8)
112 +3.3V 142 DRAK1 172 GND

113 CE2B# 143 DREQ1# 173 N.C

114 EBREQ2# (20) 144 DACK1 174 +3.3V

115 EBREQ3# (20) 145 +3.3V 175 +5V

116 EBACKO# (10) 146 SCKO 176 GND

117 TXDO 147 +3.3V 177  +12V

118 EXINT3# 148 BACK# 4) 178 GND

119 EXINT4# 149 EBACK3# (20) 179 +1.8V

120 TDI (6) 150 RESETOUT# (3) 180 GND

Note: Some signals are converted and input to the CPU or output to the user expansion board
interface connector as follows:
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D[31:0]: See figure 5.9.

A[25:0]: See figure 5.9.

RESETOUT#: The reset signal input to the CPU is directly output.

Do not drive these signals from the user expansion board.

BREQ# and BACK#: The CPU signals are directly connected to the connector pins.
Do not drive these signals from the user expansion board. To obtain the

bus mastership, use the EBREQx and EBACKX signals.

SCIF-related signals: The HDI uses these signals to communicate with the host
computer. Do not drive these signals from the user expansion board.
H-UDI-related signals: The E10A emulator uses these signals. Do not drive

these signals from the user expansion board.

IRL2: The CPU signal is directly connected to the connector pin. Do not drive this
signal from the user expansion board. To request external interrupts, use the IRLO,
IRL1, IRL3, EXINT3, and EXINT4 signals.

RESET#, MRESET#, and NMI: ORed with the related logic on the CPU board, then
input to the CPU. Refer to figure 5.9.

RDY: Pulled down on the CPU board. Control the signal so that it goes high at
wait cycle insertion and enters the high-impedance state in other cases.

(10) Bus release signals: These signals go through the related logic on the CPU

board, and are used to generate the BREQ# signal for the CPU. For the bus
release timing, refer to figures 5.6 and 5.7.

(11) CS3: Signal for monitoring the status on the CPU board.

This signal is used by the CPU board; do not drive this signal from the user expansion
board.

(12) CKIO and B_CKIO: As the CKIO output from the CPU is output to the user

expansion board interface through an external PLL, no phase error is guaranteed
(150 ps max.). As the B_CKIO output from the CPU is output to the user
expansion board interface through a bus buffer, the signal has a high drivability
but a large delay (3.6 ns max.).

o AN
(expansion bus)

e e —~g"
BREQ tBREQH | tBREQS {BACKD
(expansion bus) \ 4

L

BACK 7
(CPUL)
BACK 4 < P {CBACKD
(expansion bus) tCOFF1
A, RD, CSn, RD/WR, CAS, RAS, WEn /
(expansmn bus) — ICOFF2 _
D II \
(expansion bus) P y

7

Figure 5.6 Bus Release Timing (1)
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CKIO
(expansion bus)

—~~»1tBREQS

P

AW

tBACKD

el
BREQ tBREQH
(expansion bus)
BACK
(CPU)
BACK

(expansion bus)

tCBACKD

A, RD, CSn, RD/WR, CAS

, RAS, WEn

_ tCON1

(expansion bus)

D

=\

tCON2

(expansion bus)

Figure 5.7 Bus Release Timing (2)

Table 5.11 AC Specifications

Parameter Minimum Maximum
tBREQH 1.5ns —
tBREQS 6.0 ns —
tBACKD =tBACKD =tBACKD
tCBACKD — 10.0 ns
tCOFF1 — 8.0 ns
tCOFF2 — 17.0ns
tCON1 — 8.0 ns
tCON2 — 17.0ns
Note: =: Equivalent to CPU AC specifications
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SH7751 CPU board User expansion board

(200 mm or shorter)

»
< >

5 33V

[8]

(0]

=

3.3V S Rl 33v
_| Characteristic impedance 9 {>_
Zo = 54Q + 10Q € | Make the line between

€ | the expansion bus R2 LVT series,
CKIO output buffer 74CDC2509B 54 connector and receiver VHC series,
loh =-12 mA, lol = 12 mA 23| as short as possible. etc.
B_CKIO output buffer 74ALVCH16245 LTT

loh =-24 mA, lol =24 mA

When the characteristic impedance of the expansion board is needed to match with
the CPU board, terminal resister should be R1 = 100Q2 and R2 = 160Q.

Figure 5.8 Example of CKIO Terminal Resistor Connection
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Ul
)
SH7751

M3-6
G28F640J5

A[25..0]
D[31..0]
STATUS[1..0] >
U41:
HC138
e o | 33V 33V
_.—l 24 ——
?10 kQ ilo kQ
RD,_WR > >
_RD,_CASS._FRAME > >
Y43+ ALVCH16245
cKio : 74CDC2509 > vy >
33V 33V >
10 k Jff 10 kQ SHMWEQ
BS _»—uzs— | .
WE[3..0] —p >
SHMWED
+VSHMWE[1..O] ]  /
ALVCH16245 u40 LVC16244
FPGA
|
33V | sHMcs[s..0]
€S0 10 kQ
CS1,Cs2,
CS3.CS4, > .
CS5/CELA, - >
CS6/CE1B
MD3,_CE2A 45—
MD4 ~CE28 [ p»{Q574QST3384 >
-

CN1
.
Expansion bus

SHMA[25..0]

SHMD[31..0]

SHSTATUS[1..0]

SHMRDWR
SHMRD

SHMCKIO
SHCKIO

EXBS
SHMWE[3..0]

DSBCS2,DSBCS4

SHMCSO0,SHMCS1
SHMCS3,SHMCS5
SHMCS6

SHCE2A
SHCE2B

|

Figure 5.9 Configuration of User Expansion Board Interface Circuit (CN1)-1

RENESAS

Rev. 1.0, 09/00, page 93 of 138




U1 CN1
— T
SH7751 3V Expansion bus
10 KQ
——U40 —
EXINT3,EXINT4
EBREQOA,EBREQOB
EPGA EBREQ2,EBREQ3
|| EBACKOEBACK2
A EBACK3
DRAKO | SHDRAKO
3.3V
10 KQ ?
_DREQO | P SHDREQO
U32 '
3.3V FPGA
10 KQ _IRL2
_IRL[3..0] g P SHIRL[3..0]
_IRL[3..0]
_RDY P sHrRDY
3.3V ilO K| 33v
10 KQ ? B i 10 KQ v
_BREQ,_BSACK {« | P»{ sHBREQ
_BACK,_BSREQ P»| sHBACK
_RESET [ P SHRESET
DX20M-36S
——cN23
LVC240
10 KQ 10 KQ 10 KQ
33V 33V 33V
l EXMRST
MRESET
s .
U40 LVCo8
< EXRST
U4
FPGA LVCo8
SHNMI
Ml |———— ' U2
LVCO08
| N —
Logic on the board

Figure 5.10 Configuration of User Expansion Board Interface Circuit (CN1)-2
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Ul CN1

)
SH7751 Expansion bus
M3-6
G28Fe4055 [ FLRDY
DACKO ¢ P SHDACKO
33V 33V 32
10 K2 — 10 KQ i FPGA
DRAK1 T SHDRAK1
_DREQ1 te§ + SHDREQ1
DACK1 SHDACK1
SCK P scko
S g
P scke
P RXD2,TXD2
33V RTS2,CTS2
10 KQF
+ P( 101516
33V
i v ua? u45
10 KO | LT1330 |QS74QST3384]
MDO,SCK2 |} |
MD2,RXD2
MD1,TXD2
MD8,RTS2 <
MD7,CTS2
MDS,I01S16 |«
TCLK P TCLK
MD5 P»{ MODE5
46 33V 33V
TRSTTDI SHTRST,SHTCI
TCK,TMS GND 10k - 10K SHTCK,SHTMS
_ASEBRK_BRKAK [ s f SHASEBREAK
TDO + SHTDO
CN23 + 33V
DX20M-36S | 10 KQ i
_HARDSTE 1§ SHSTBY
— —

Figure 5.11 Configuration of User Expansion Board Interface Circuit (CN1)-3
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545 PCI Interface

This board is provided with the compact PCI interface using the on-chip PCI bridge in the SH7751.
The 33MHz, 32bit, 3.3V PCl interface is supported.

This CPU board is not provided with PCI drivers. When using the PCI interface, you must provide
your own driver software.

Figure 5.12 shows the pin arrangements for the compact PCI connectors. Pin assignments for the
compact PCI connectors are listed in tables 5.12 and 5.13. Refer to the CPU hardware manual for
those pins that have no numbers in the pin function column. The pin signal level is 3.3 V, which is
equivalent to that of the SH7751 CPU.

A WARNING

1. Always switch OFF the CPU board and the compact PCI
backplane before connecting or disconnecting any CABLES
or CONNECTORS. Failure to do so will result in a FIRE
HAZARD and will damage the PCI system and the CPU board
or will result in PERSONAL INJURY. The USER PROGRAM
will be LOST.

2. Do not insert any other boards into the two slots next to
the component side (PCI connector side) of the CPU board
when the CPU board is inserted into the PCI backplane.
Failure to do so will result in a FIRE HAZARD due to contact
between the CPU board and another board, and will damage
the PCI system and the CPU board or will result in
PERSONAL INJURY. The USER PROGRAM will be LOST.

Note: Before connecting the CPU board to the compact PCI backplane, turn off SW1 to separate the
3.3V generator on the CPU board. In this case, the CPU board receives the 5V and 3.3V
power from the backplane and operates with the 3.3V interface (see figure 5.13).

00000000 DO00000000000000000000000000000000
00000000 D00000000000000000000000000000000

00000000/ \JO00000000000000000000000000000000
00000000 000000000000000000000000000000000
00000000 000000000000000000000000000000000

Figure 5.12 Compact PCI interface CN19 and CN20 Pin Arrangements
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Table 5.12 Compact PCI Interface J1 Connector (CN19) Pin Assignments

Pin Pin Pin Pin Pin
Pin Pin Func- Pin Pin Func- Pin Pin Func- Pin Pin Func- Pin Pin Func-
No. Name tion No. Name tion No. Name tion No. Name tion No. Name tion

Al 5V B1 -12v Cl TRST D1 12v E1 5V

A2 TCK B2 5V C2 TMS D2 TDO E2 TDI

A3 INTA (1) B3 INTB (1) C3 INTC (1) D3 5V E3 INTD (1)
A4 Reserve B4 GND C4 V(/O) (7) D4 INTP (6) E4 INTS (6)
A5 Reserve B5 Reserve C5 RST D5 GND E5 GNT

A6 REQ B6 GND C6 3.3V D6 CLK E6 AD31

A7 AD30 B7 AD29 C7 AD28 D7 GND E7 AD27

A8 AD26 B8 GND C8 V(/0) (7) D8 AD25 E8 AD24

A9 C/BE3 B9 IDSEL C9 AD23 D9 GND E9 AD22

A10 AD21 B10 GND C10 3.3V D10 AD20 E10 AD19

All AD18 B11 AD17 Cl1 AD16 D11 GND E1l C/BE2
Al12 B12 C12 D12 E12

Al3 B13 C13 D13 E13

Al4 B14 C14 D14 E14

Al5 3.3V B15 FRAME C15 IRDY D15 GND E15 TRDY
Al6 DEVSEL B16 GND C16 V(/0) (7) D16 STOP E16 LOCK
Al7 3.3V B17 SDONE Cl17 SBO D17 GND E17 PERR
Al18 SERR B18 GND C18 3.3V D18 PAR E18 C/BE1l
Al9 3.3V B19 AD15 C19 AD14 D19 GND E19 AD13

A20 AD12 B20 GND C20 V(/0) (7) D20 ADi11 E20 AD10

A21 3.3V B21 AD9 C21 ADS8 D21 M66EN E21 C/BEO
A22 AD7 B22 GND C22 3.3V D22 AD6 E22 AD5

A23 3.3V B23 AD4 C23 AD3 D23 5V E23 AD2

A24 AD1 B24 5V C24 V(/O) (7) D24 ADO E24 ACK64 (2)
A25 5V B25 REQ64 (2) C25 ENUM (4) D25 3.3V E25 5V
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Table 5.13 Compact PCI Interface J2 Connector (CN20) Pin Assignments

Pin Pin Pin Pin Pin
Pin  Pin Func- Pin Pin Func- Pin Pin Func- Pin Pin Func- Pin Pin Func-
No. Name tion No. Name tion No. Name tion No. Name tion No. Name tion
Al CLK1 B1 GND Cl REQ1 D1 GNT1 E1 REQ2
A2 CLK2 B2 CLK3 C2 SYSEN D2 GNT2 E2 REQ3
A3 CLK4 B3 GND C3 GNT3 D3 REQ4 (3) E3 GNT4 (3)
A4 V(/O) (7) B4 Reserve C4 C/IBE7 (2) D4 GND E4 C/BE6 (2
A5 C/BE5 (2) B5 GND C5 V(/0) (7) D5 CI/BE4 (2) E5 PAR64 (2)
A6 AD63 ) B6 AD62 (2) C6 AD61 (2) D6 GND E6 AD60 (2)
A7 AD59 (2) B7 GND C7 V(/O) (7) D7 AD58 (2) E7 AD57 (2
A8 AD56 (2) B8 AD55 (2) C8 AD54 (2) D8 GND E8 AD53 (2
A9 AD52 (2) B9 GND C9 V(@/0) (7) D9 AD51 (2) E9 AD50 (2)
Al0 AD49 (2) B10 AD48 (2) Cl10 AD47 (2) D10 GND E10 AD46 (2
All AD45 (2) B11l GND Cl1 V(/O) (7) D11 AD44 (2) E11 AD43 (2
Al2 AD42 (2) Bl12 AD41 (2) Cl2 AD40 (2) D12 GND E12 AD39 (2
Al3 AD38 (2) B13 GND C13 V(/O) (7) D13 AD37 (2) EI13 AD36 (2
Al4 AD35 (2) Bl14 AD34 (2) Cl4 AD33 (2) D14 GND E14 AD32 (2
Al5 Reserve B15 GND C15 FAL (4 D15 REQ5 (3) E15 GNT5 (3)
Al16 Reserve B16 Reserve C16 DEG 4 D16 GND E16 Reserve
Al7 Reserve B17 GND C17 PRST (5) D17 REQ6 (3) E17 GNT6 (3)
Al18 Reserve B18 Reserve C18 Reserve D18 GND E18 Reserve
A19 GND B19 GND C19 Reserve D19 Reserve E19 Reserve
A20 CLK5 B20 GND C20 Reserve D20 GND E20 Reserve
A21 CLK6 B21 GND C21 Reserve D21 Reserve E21 Reserve
A22 GA4 B22 GA3 C22 GA2 D22 GAl E22 GAO
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Note: Some signals are converted and input to the CPU or output to the compact PCI connectors,
and some pins do not work because part of the PCI functions is not supported by the CPU
board, as follows:

(1) INTAto INTD: The signals are connected to the IRL2 of the CPU through the logic on
the CPU board. For details, refer to section 5.5, On-Board Registers.

(2) 64bit bus signals: NC on the CPU board. If necessary, deal with those signals
appropriately on the expansion board. Note that ACK64# and REQ64+# are pulled up
on the CPU board.

(3) Signals for slots 6 to 8: Pulled up. No board can be connected to these slots.

(4) Signals for hot swapping: Pulled up. These pins do not work.

(5) PRST#: ORed with the related logic on the CPU board, then input to the CPU.

Refer to figure 5.14.

(6) INTP# and INTS#: NC on the CPU board. If necessary, deal with those signals
appropriately on the expansion board.

(7) V(I/O): The CPU board does not use this signal. Note that a decoupling capacitor is
inserted between this pin and GND.
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—SH7751 CPU board

CN3
Power CNSW:\lNl 7 CN1
5V connector "
+_’
S0 GND o 0 : P 5y
OFF By
CN19 On-board logic GND )
CN20 Expansion
+5V PCI +5V 22V bus
> connector | /77 connector
| L84 oy [on_swi2 e P 133V
5V->33V LT1084
Regulator Q\0— 5 3.3V -> 1.8 V]out veeo
+3.3V > +33V 0 Regulator vee
OFF I— GND
——Pp{ 18V
GND GND
—Pp
SW1-1 and SW1-2 are included in one component.
| They are turned on or off at the same time.
Figure 5.13 CPU Board Power Supply Lines
SH7751 CPU boal’d E10A emulator
connector
From PCI
connector enzo Noise reduction oNzs
PRST# — — —P»
circuit RESET
From ROM ICE TP56
SYSTEM _RESET
IcE_RESET () -
Ul
SW3
PRESET H| MBa771 | —— SH7751
5y (Power-on /RESET Expansion bus
detection |—> reset circuit) connector
SW2 CN1
MRESET RESETOUT #
P /MRESET
’_O RESET#
MRESET#
- J

Figure 5.14 Reset Signal Lines
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5.5 On-Board Registers

The CPU board has on-board registers to control interrupts from the external interface. These register
contents can be modified by user program. Table 5.14 lists the on-board registers.

Table 5.14 On-Board Registers

Register Name Formal Name R/W Address

PINT PCI interrupt source register R H’04000000
PINTMASK PCI interrupt mask register R/W H’04000002
EXINT External interrupt source register R H'04000004
EXINTMASK External interrupt mask register R/W H’04000006
NMIMASK NMI mask register R/W H’04000008

[1] PCI interrupt source register (PINT)

Bit 15 14 13 12 11 10 9 8

Name Not used |Not used |Not used |Not used |PINT3  |PINT2 |PINT1 |PINTO
R/W R R R R R R R R

Initial value |— — — 0 — — — —

Bit 7 6 5 4 3 2 1 0

Name Not used |Not used |Not used |Not used |Not used |Not used |Not used |Not used
R/W R R R R R R R R

Initial value |— — — — — — — —

—: Undetermined

This register monitors the signal levels of the compact PCI interface interrupt lines. When an IRL2
interrupt is requested to the CPU, the source of the interrupt can be determined by reading this
register. To clear the interrupt source, access to the corresponding expansion board controller.

Bit 11: PINT3
0: PCI INTD signal driven low (interrupt requested)
1: PCI INTD signal driven high (interrupt not requested)

Bit 10: PINT2
0: PCI INTC signal driven low (interrupt requested)
1: PCI INTC signal driven high (interrupt not requested)

Bit 9: PINT1
0: PCI INTB signal driven low (interrupt requested)
1: PCI INTB signal driven high (interrupt not requested)
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Bit 8: PINTO
0: PCI INTA signal driven low (interrupt requested)
1: PCI INTA signal driven high (interrupt not requested)

[2] PCI interrupt mask register (PINTMASK)

Bit 15 14 13 12 11 10 9 8

Name Not used |Not used |Not used |Not used |PINTMA |PINTMA |PINTMA |PINTMA
SK3 SK2 SK1 SKO

R/W R R R R R/W R/W R/W R/W

Initial value |— — — 0 0 0 0 0

Bit 7 6 5 4 3 2 1 0

Name Not used |Not used |Not used |Not used |Not used |Not used |Not used |Not used

R/W R R R R R R R R

Initial value |— — — — — — — —

—: Undetermined

This register masks interrupt input from the compact PCI interface. When a PINT bit becomes 0 while
the corresponding bit in this register is set to 1, the IRL2 signal is input to the CPU.

Bit 11: PINTMASK3
0: Masks the PCI INTD interrupt
1: Accepts the PCI INTD interrupt

Bit 10: PINTMASK2
0: Masks the PCI INTC interrupt
1: Accepts the PCI INTC interrupt

Bit 9: PINTMASK1
0: Masks the PCI INTB interrupt
1: Accepts the PCI INTB interrupt

Bit 8: PINTMASKO
0: Masks the PCI INTA interrupt
1: Accepts the PCI INTA interrupt
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[3] External interrupt source register (EXINT)

Bit 15 14 13 12 11 10 9 8
Name Not used |Not used |Not used |EXINT4 |[EXINT3 [Reserved|Reserved|EXINTO
R/W R R R R R R R R
Initial value |— — — — — 1 1 —
Bit 7 6 5 4 3 2 1 0
Name Not used |Not used |Not used |Not used [Not used [Not used [Not used [Not used
R/W R R R R R R R R
Initial value |— — — — — — — —

—: Undetermined

This register monitors the signal levels of the external interrupt lines. When an IRL2 interrupt is
requested to the CPU, the source of the interrupt can be determined by reading this register. To clear
the interrupt source, access to the corresponding resource that has generated the interrupt.

Bit 12: EXINT4
0: User expansion board interface EXINT4 signal driven low (interrupt requested)
1: User expansion board interface EXINT4 signal driven high (interrupt not
requested)

Bit 11: EXINT3
0: User expansion board interface EXINT3 signal driven low (interrupt requested)
1: User expansion board interface EXINT3 signal driven high (interrupt not
requested)

Bit 10: Reserved
Always read as 1

Bit 9: Reserved
Always read as 1

Bit 8: EXINTO
0: Serial interface DCD signal driven low (interrupt requested)
1: Serial interface DCD signal driven high (interrupt not requested)
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[4] External interrupt mask register (EXINTMASK)

Bit 15 14 13 12 11 10 9 8

Name Not used |Not used |[Not used |[EXINTM |EXINTM |Reserved|Reserved |EXINTM
ASK4 ASK3 ASKO

R/W R R R R/W R/W R/W R/W R/W

Initial value |— — — 0 0 0 0 0

Bit 7 6 5 4 3 2 1 0

Name Not used |Not used |Not used |Not used |Not used |Not used |Not used |Not used

R/W R R R R R R R R

Initial value |— — — — — — — —

—: Undetermined

This register masks external interrupt input. When an EXINT bit becomes 0 while the corresponding
bit in this register is set to 1, the IRL2 signal is input to the CPU.

Bit 12: EXINTMASK4
0: Masks the user expansion board interface EXINT4 interrupt
1: Accepts the user expansion board interface EXINT4 interrupt

Bit 11: EXINTMASK3
0: Masks the user expansion board interface EXINT3 interrupt
1: Accepts the user expansion board interface EXINT3 interrupt

Bit 10: Reserved
Always write 0.

Bit 9: Reserved
Always write 0.

Bit 8: EXINTMASKO
0: Masks the serial interface DCD interrupt
1: Accepts the serial interface DCD interrupt
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[5] NMI interrupt mask register (NMIMASK)

Bit 15 14 13 12 11 10 9 8

Name Not used |Not used |Not used |Not used |Not used |CS56EN |SWNMIM [EXNMIM
ASK ASK

R/W R R R R R R/W R/W R/W

Initial value |— — — 0 0 0 0 0

Bit 7 6 5 4 3 2 1 0

Name Not used |Not used |Not used |Not used |Not used |Not used |Not used |Not used

R/W R R R R R R R R

Initial value |— — — — — — — —

—: Undetermined

This register masks the input from the abort switch and the NMI input from the user expansion board.
It also specifies whether the CS5 and CS6 areas are released to the user expansion bus.

Bit 10: CS56EN
1: Outputs CS5 and CS6 area accesses to the expansion bus.
0: Does not output CS5 and CS6 area accesses to the expansion bus.

Bit 9: SWNMIMASK
1. When the SW4 (abort switch) is pressed, an NMI signal is input to the CPU.
0: When the SW4 is pressed, no NMI signal is input to the CPU (execution cannot be
aborted).

Bit 8: EXNMIMASK
1: Enables the NMI signal to be input from the EXNMI (expansion bus) and
ICE_NMI (the test pin for ROM-ICE).
0: Masks the NMI signal from the EXNMI and ICE_NMI.
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5.6 E10A Emulator Interface

The CPU board is equipped with a Hitachi-UDI port connector (CN23) to which an SH7751 E10A
emulator can be connected. SH7751 H-UDI and AUD signals are connected directly to this connector.

Figure 5.15 shows the pin arrangement of the Hitachi-UDI port connector (CN23). Table 5.15 shows
the pin assignment for the Hitachi-UDI port connector (CN23).

Hitachi-UDI port connector (top view)

Pin 35 Pin 1
CN23

/ N\

Pin 36 Pin 2

To CN1

Figure 5.15 Hitachi-UDI Port Connector (CN23) Pin Arrangement
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Table 5.15 Hitachi-UDI Port Connector (CN23) Pin Assignment

Pin No.  Signal Name Input/Output Pin No. Signal Name Input/Output
1 AUDCK I/0 19 T™MS |
2 GND 20 GND

3 AUDATAO I/0 21 TRST

4 GND 22 GND

5 AUDATA1L I/0 23 TDI

6 GND 24 GND

7 AUDATA2 le} 25 TDO o
8 GND 26 GND

9 AUDATA3 I/0 27 ASEBRKAK I
10 GND 28 GND

11 AUDSYNC le} 29 NC

12 GND 30 GND

13 NC 31 RESET o
14 GND 32 GND

15 NC 33 GND

16 GND 34 GND

17 TCK | 35 NC

18 GND 36 GND
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5.7 On-Board LEDs

The CPU board has eight LEDs to indicate the operating status such as power or CPU status.

CN1(53481-1809)

N
o/ [3]

o

9 9

o |5, |EE
]
= AT93C46

| K soro

-955S

0T-£006
Jlawlojsuel |
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Figure 5.16 shows the LED locations on the CPU board and table 5.16 shows the LED functions.
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Figure 5.16 LED Locations
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Table 5.16 LED Functions

Part No. Color Function Name  Status Indicated When Lit

D1 Green LNK Valid link has been made through the LAN
interface.

D2 Green RX The CPU board is receiving external data through
the LAN interface.

D3 Green TX The CPU board is sending data through the LAN
interface.

D18 Green Normal The CPU (SH7751) is in normal operation state.

D19 Green SLEEP The CPU (SH7751) is in sleep mode.

D20 Green STAND-BY The CPU (SH7751) is in standby mode.

D21 Green RESET The CPU (SH7751) is in reset state.

D22 Red PWR 5.0V, 3.3V, and 1.8V power are all being supplied

to the board correctly.
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5.8 Parts Layout

The parts layout of the CPU board is shown in figure 5.17. The shaded parts are uninstalled.
Uninstalled parts are listed in table 5.17.

Table 5.17 List of Uninstalled Parts

Part Name Quantity Part Number

281E1602-107M 4 C79, C80, C88, C243

269M1602-226M 10 C61, C62, C64, C65, C70, C74, C87, C89, C101, C229
269M1602-335M 4 C68, C72, C429, C430

269M3502-475M 1 C153

GRM39F103250 2 C56, C427

GRM39F104225 51 C55, C67, C69, C73, C145, C237, C238, C239, C240,

C241, C242, C409, C410, C411, C420, C421, C422, C423,
C428, C63, C66, C71, C85, C86, CI1, C97, C98, C99,
C100, C160, C161, C162, C163, C164, C228, C231, C232,
C233, C234, C235, C236, C412, C413, C414, C415, C416,
C417, C418, C419, C425, C426

GRM39F105210 6 C93, C96, C108, C109, C110, C111
GRM40F105Z716 3 C76, C78, C165
GRM39CH150J50 27 C120, C122, C124, C126, C128, C130, C133, C135, C137,

C139, C141, C143, C144, C146, C147, C121, C123, C125,
C127, C129, C131, C132, C134, C136, C138, C140, C142

GRM39CH181J50 17 C192, C193, C194, C195, C196, C197, C198, C199, C200,
C201, C202, C203, C204, C205, C206, C207, C208

GRM39CH220J50 4 C166, C167, C168, C169

GRM39CH221J50 6 C75, C77, C102, C103, C118, C119

GRM39F224716 1 C152

GRM39F271350 2 C94, C95

GRMB39F333Z50 1 C90

GRM39F334710 2 C106, C107

GRM39CH470J50 4 C148, C149, C150, C151

GRM39F473725 1 C92

GRM39CH560J50 6 C112, C113, C114, C115, C116, C117

GRM39CH561J25 2 C104, C105

GRM39F684210 2 C83, C84

MCR10EZH-J000 13 R18, R19, R85, R87, R89, R91, R2, R5, R7, R119, R120,
R137, R148
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Table 5.17 List of Uninstalled Parts (cont)

Part Name Quantity Part Number

MCR10EZH-J100 1 R26, R83

MCR10EZH-J101 3 R110, R111, R83

MCR10EZH-J102 3 R27, R28, R82

MCR10EZH-J103 9 R71, R72, R37, R77, R78, R79, R94, R131, R132

MCR10EZH-J104 3 R80, R81, R93

MCR10EZH-J105 1 R74

MCR10EZH-J153 4 R86, R88, R90, R92

MCR10EZH-J200 1 R84

MCR10EZH-J220 25 R46, R48, R50, R52, R54, R56, R59, R61, R63, R65, R67,
R69, R70, R47, R49, R51, R53, R55, R57, R58, R60, R62,
R64, R66, R68

MCR10EZH-J270 2 R44, R45

MCR10EZH-J392 2 R24, R25

MCR10EZH-J432 4 R33, R34, R35, R36

MCR10EZH-J470 1 R73

MCR10EZH-J473 2 R22, R23

MCR10EZH-J512 5 R29, R30, R31, R32, R133

MCR10EZH-J750 6 R38, R39, R40, R41, R42, R43

MNR14-EOAB-JO00 3 NR13, NR14, NR68

MNR14-EOAB-103 17 NR11, NR12, NR6, NR7, NR8, NR15, NR16, NR44, NR45,
NR46, NR47, NR48, NR49, NR53, NR54, NR55, NR56

MNR14-E0AB-220 3 NR50, NR51, NR52

MNR14-E0AB-221 1 NR10

MNR14-EO0AB-472 1 NR9

RJ-6P-103 1 VR1

HSJ1003-01-010 1 CN5

IL-G-2P-S3T2-E 1 CN6

DIC152-8P 1 CN7

IL-G-4P-S3T2-E 1 CN8

D02-M15SAG-13LQ 1 CN9

HIF3F-40PA-2.54DSA 2 CN10, CN11

MH11061-D2 1 CN12

FH10-24S-1SH 1 CN13
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Table 5.17 List of Uninstalled Parts (cont)

Part Name Quantity Part Number

UB1112C-D1 1 CN14

DM11351-75-2 1 CN17

53553-1607 1 CN21

DM11351-75-3 1 CN22

410-96-202 18 J11,J12, J13, J14, J15, J16, J22, J24, J28, J29, J2A, J2B,
J41, J43, J44, 345, J47, J48

310-93-103+310-93-101 2 J31, J32

310-93-103 2 J33,J34

HRF22 8 D4, D5, D6, D7, D8, D9, D10, D11

SML-210MT 4 D13, D14, D15, D16

HSM221C 1 D17

CDRH62B-330 2 L1, L2

LQH3C471 9 L3, L4, L5, L6, L7, L13, L14, L15, L16

BLAG62B01 5 L8, L9, L10, L11, L12

SMD150-2 1 F2

LT1031 2 Ul2, U13

LTC1472 2 Ul4, Uls

TDA1308T 1 Ul6

NJM386M 1 ul7

AD1819AJST 1 Ul8

HD64465BP 1 u29

HD74LS04FP 1 U30

MQ-200 1 u31

HD6473214F16 1 U33

HD74HC164FP 1 uU34

0QS3245Q 1 U35

LT1330CG 1 u3s8

MAX471CSA 1 U39

LT1085CM 1 Us0

HD74ALVC16834T-EL 1 U53

CX5F-12.288MHz 1 X1

SG8002CA-12MHz 1 0SC2

SG8002CAPCCB_22MHZ 1 OSC5
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Figure 5.17 Parts Layout (Mounting Side)
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59 Initialization

59.1 Initializing Resources

Table 5.18 shows which CPU board resources are initialized.

Table 5.18 Resource Initialization

Cause of Initialization

Start-up or
Power-On Reset
Switch Pressed

Manual Reset Switch
Pressed

Interrupt Monitor
Resource Hardware Program

Hardware

Monitor
Program

Remarks

SH7751 CPU

o]

MMU

o

CACHE

TLB

CCN

INTC

o

O

UBC

CPG

WDT

BSC

0/ 0|0

DMAC

T™MU

RTC

SCI

SCIF

Used by monitor

PCIC

0|00l 0|0O|0O

O0/0|/0O|O0O|O|O|O|O|O|O|O|O|O|O|0O|0O]|O
0/ 0|0

I/0O PORT

AUD

Initialized by
TRST

H-UDI — —_

Initialized by
TRST

ASERAM — —

Initialized by
TRST
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Table 5.18 Resource Initialization (cont)

Cause of Initialization

Start-up or

Power-On Reset Manual Reset Switch

Switch Pressed Pressed
Interrupt Monitor Monitor
Resource Hardware Program Hardware Program Remarks
Interrupt controller (0] (0] (0] (@)
On-board register (0] (0] (0] —
SDRAM (Monitor program — (0] — (@)

work area)

SDRAM (User program area) — — — —

Notes: 1. O: Initialized
—: Not initialized
2. When, during HDI and CPU board operation, a power-on reset occurs due to a power
supply voltage drop or for other reasons, a “Power on reset is detected.” message box is

displayed. However, in this case the CPU general registers and control registers are not
initialized. Change settings as necessary or restart the HDI.
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9.2 Procedure for Making Initial Settings of the CPU Bus State Controller (BSC)

Figure 5.18 is a flowchart of the procedure for initial settings of the bus state controller (BSC). For
information on the settings of each BSC register, please refer to section 5.9.3, Initial Settings of CPU
Bus State Controller (BSC).

START

-
-

WTCNT (MCR=10xxxxxx ) (MCR=5OXXXXXX )

WTCSR

SDMR3 SDMR3

i

BCR1 ( RTCOR=A503 ) RTCNT

(temporary setting)

4—'4_

BCR2 (RTCOR (depends J

RFCR on frequency)

WCR1 RECR

RTCSR

Enty

WCR2 RTCSR

Note: Auto-refresh x eight times

-

WCR3
END

R

Figure 5.18 Procedure for Setting BSC Settings
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5.9.3 Initial Settings of CPU Bus State Controller (BSC)

The clock mode is set to 5 in the CPU board. In the bus state controller (BSC) registers, bits
corresponding to areas 0, 1 and 3 must not be modified because these areas are assigned to resources
the CPU board. If these bits are modified, the CPU board will not operate. The following shows the
initial BSC register values set by the monitor program. In the figures, the shaded bits must not be
modified. Separate figures are used to show the register values that depend on the operating frequency
(CKIO).

Register Values at 83.5 MHz and 55.7 MHz:

e BCR1 (H'FF800000) = H'00080008
Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
No.
Bit [ENDI |[MAST|AO - - - DPUP[IPUP |- - Al A4 BREQ|PSHR|MEM [-
name|AN [ER  |MPX MBC (MBC |EN MPX

Initial |0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0
value

Bit [15 14 13 12 11 10 |9 3 7 6 5 4 3 2 1 [0
No.
Bit [HIz |Hiz |A0 (A0 |JAO |A5 (A5 |A5  |A6 (A6 |A6 [DRA [DRAM |DRAM |-  |A56
name(MEM |CNT |BST2 [BST1 |BSTO |BST2 [BST1 |BSTO [BST2 [BST1 |BSTO [MTP2 [TP1 [TPO PCM
Initial |0 0 (0} 0 0 0 0 0 0 0 0 0 1 0 0O |0
value

« BCR2 (H'FF800004) = H' FFF8
Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.
Bit |AO IAO A6 A6 AS AS A4 A4 |A3 A3 A2 A2 Al ALl PORT
namelsSz1 [SZ0 |SZ1 [Sz0 |Sz1 [Sz0 [Ssz1 |SZz0 [Sz1 |SZz0 |sz1 (Sz0 |Sz1 (szO EN

Initial |1 1 1 1 1 1 1 1 1 1 1 1 1 0 0 0
value

« WCRS3 (H'FF800010) = H'07777000
Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
No.
Bit | - - - - A6 A6 A6 - AS AS AS - A4 A4 |A4
name SO H1 HO SO H1 HO SO H1 HO

Initial [0 0 0 0 0 1 1 1 0 1 1 1 0 1 1 1
value
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Bit [15 14 13 12 11 10 |9 3 7 6 5 4 3 2 1 0
No.

Bit | A3 JA3  |A3 | A2 A2 |A2 | A1 |A1  |A1 | A0  |AO |AD
name SO [H1 |HO SO [H1 |HO SO [H1 |HO SO [H1I |HO
Initial |0 1 1 1 0 0 0 0 0 0 0 0 0 0 0 0
value

+ RTCSR (H'FF80001C) = H'A510

Bit [15 14 13 12 11 10 |9 3 7 6 5 4 3 2 1 0
No.

Bit | - - - - - - - CMF [CMIE |CKS2 |CKS1 [CKSO |OVF |OVIE [LMTS
name

Initial |1 0 1 0 0 1 (0] 1 0 0 0 1 (0} 0 0 0
value

* RTCNT (H'FF800020) = H'A500

Bit [15 14 13 12 11 10 |9 3 7 6 5 4 3 2 1 (o]
No.

Bit | - - - - - - -

name

Initial |1 0 1 (0] 0 1 (0] 1 0 0 0 0 (6} (0] 0 0
value

 RFCR (H'FF800028) = H'A400

Bit [15 14 13 12 11 10 |9 3 7 6 5 4 3 2 1 (o]
No.

Bit | - - - - -

name

Initial |1 0 1 0 0 1 (0] 0 0 0 0 0 (6} (0] 0 0
value
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Register Values at 83.5 MHz:

* FRQCR (H'FFC00000) = H'OEOA

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit - - - - CK PLL |PLL |[IFC2 |IFC1 |IFCO |BFC2 [BFC1 |BFCO [PFC2 [PFC1 |PFCO
name OEN [1EN [2EN

Initial |0 (0] (0] (0] 1 1 1 0 0 0 0 0 1 0 1 0
value

« WCRL1 (H'FF800008) = H'77771724

Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
No.

Bit - DMA |DMA |DMA A6 A6 A6 A5 A5 IAS A4 A4 A4
name W2 |Iwl w0 W2 |lwl [IW0 W2 |Iwl (W0 W2 |lwl (W0
Initial |0 1 1 1 0 1 1 1 0 1 1 1 (0] 1 1 1
value

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit - IA3 A3 A3 A2 A2 A2 Al Al AL - AO AO IAO
name W2 |Iwl [IwW0 W2 |lwl [IW0 W2 |Iwl (W0 W2 |IWl [IW0
Initial |0 0 0 1 0 1 1 1 0 0 1 0 0 1 0 0
value

e WCR2 (H'FF80000C) = H'FFFE4EF7

Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
No.

Bit A6 A6 A6 AG A6 A6 A5 A5 IAS A5 A5 IAS A4 A4 A4 -
namew2 Wi |wWO0 B2 Bl BO w2 w1 |WO0 B2 Bl BO W2 w1 |WO0

Initial |1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0
value

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit A3 A3 A3 A2 A2 A2 Al AL ALl AO IAO IAO AO AO IAO
namew2 (W1 (WO w2 wi wo w2 (wi (W0 w2 |wW1 |WO0 B2 Bl BO
Initial |0 1 (6] 0 1 1 1 0 1 1 1 1 (6] 1 1 1
value
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*+ MCR (H'FF800014) = H'480923F4

Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
No.

Bit RASDIMR |TRC ([TRC |[TRC |- - - TCAS |- TPC2 [TPC1 |TPCO |- RCD1 [RCDO
name SET [2 1 0

Initial |0 1 0 0 1 0 0 0 0 0 0 0 1 0 0 1
value

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit TRWL[TRWL|TRWL[TRAS [TRAS |[TRAS [BE SZ1 [Sz0 |AMX [AMX |JAMX JAMX [RFSH|RMODE|EDO
name|2 1 (6] 2 1 (6] EXT |2 1 0 MODE
Initial |0 0 1 0 0 0 1 1 1 1 1 1 0 1 0 0
value

+ SDMR3 (H'FF940088) = H'00

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit - - - - - - - - D7 D6 D5 D4 D3 D2 D1 DO
name

Initial |- - - - - - - - 0 0 0 0 0 (0] 0 0
value

+ RTCOR (H'FF800024) = H'A526

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit | - - - - - - -

name

Initial |1 0 1 0 0 1 0 1 0 0 1 0 0 1 1 0
value

Register Values at 55.7 MHz:

+ FRQCR (H'FFC00000) = H'OE13

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit - - - - CK PLL |PLL [IFC2 |IFC1 |IFCO |BFC2 [BFC1 |BFCO [PFC2 [PFC1 |PFCO
name OEN [1EN [2EN

Initial |0 (0] (0] 0 1 1 1 0 0 0 0 1 0 0 1 1
value
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+ WCRI1 (H'FF800008) = H'77771714

Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
No.

Bit - DMA |DMA |DMA A6 A6 A6 IAS A5 IAS A4 A4 A4
name W2 |Iwl w0 W2 |lwl [IW0 W2 |Iwl (W0 W2 |Iwl (W0
Initial |0 1 1 1 0 1 1 1 0 1 1 1 0 1 1 1
value

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit - A3 A3 A3 A2 A2 A2 ALl Al AL - AO AO IAO
name w2 JIwl [IW0 w2 [Iwl |IW0 w2 [IwWl [IW0 w2 |IwWl (IWO
Initial |0 0 (0} 1 0 1 1 1 0 (0} 0 1 (0] 1 0 0
value

« WCR2 (H'FF80000C) = H'FFFE4EEF

Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
No.

Bit A6 IAG A6 A6 A6 A6 AS A5 IAS A5 A5 IAS A4 A4 A4 -
namew2 W1 (WO B2 Bl BO W2 (w1l |WO0 B2 Bl BO W2 W1l |WO0

Initial |1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 0
value

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit A3 IA3 A3 A2 A2 A2 Al AL Al AO IAO AO AO AO IAO
namew2 W1 |WO0 w2 (wi wo w2 Wi WO |wW2 (W1 |WO B2 Bl BO
Initial |0 1 0 0 1 1 1 0 1 1 1 0 1 1 1 1
value

e MCR (H'FF800014) = H'400923F4

Bit 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16
No.

Bit RASDIMR |TRC ([TRC |[TRC |- - - TCAS |- TPC2 [TPC1 |TPCO |- RCD1 |RCDO
name SET |2 1 0

Initial |0 1 0 0 0 0 0 0 0 0 0 0 1 0 0 1
value

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
No.

Bit TRWL[TRWL|TRWL[TRAS [TRAS |[TRAS [BE SZ1 [Sz0 |AMX [AMX |JAMX JAMX [RFSH|RMODE|EDO
name|2 1 (6] 2 1 (6] EXT |2 1 0 MODE
Initial |0 0 1 0 0 (6] 1 1 1 1 1 1 0 1 (0} (0}
value
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« SDMR3 (H'FF940088) = H'00

Bit 15 14 13 12 11
No.

10

Bit |- - -
name

D7

D6

D5

D4

D3

D2

D1

DO

Initial |- - -
value

*+ RTCOR (H'FF800024) = H'A5

19

Bit 15 14 13 12 11
No.

10

Bit |- - -
name

Initial [1 0 1 0 0
value
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Section 6 Notes and Troubleshooting

6.1 Notes

1. User Program Execution

(1) When executing a user program, the following interrupts cannot be used. This is because the
monitor program is using the following CPU functions for debugging purposes.
» User Break Controller (UBC)

e Serial Communication Interface with FIFO (SCIF)
»  TRAPA#255 Trap instruction

(2) If a single-step execution is performed for an illegal instruction, the program counter will not
increment the count; do not perform single-step executions for illegal instructions.

(3) When a multiple step execution is performed for a program that contains the SLEEP instruction
(from the [Step...] menu), the execution speed ([RATE]) must be set to 6 in the Step Program
dialog box. Otherwise an error ((Command not ready] error) will occur when the SLEEP
instruction is executed, and execution from then on cannot be accepted. In such case, press the
abort switch (SW4) and start execution again.

(4) The abort switch (SW2) input is ORed with the NMI input from the expansion board, then
input to the NMI pin in the CPU. Therefore, if the NMI is fixed to low level on the user
expansion board, the abort switch will not work.

(5) During single-step execution, standard C libraries are also executed. To return to a higher-level
function, use Step Out. In a for statement or a while statement, executing a single step does not
move execution to the next line. To move to the next line, execute two steps.

2. The monitor program uses NMI and SCIF interrupts, so the user can use interrupts of mask level
14 or lower. If an interrupt is set to mask level 15, correct operation cannot be guaranteed. The
default mask level is set to 14.

3. Interrupt and Exception Display

(1) The following interrupts and exceptions are displayed on the status bar during user program
execution.

» Address error

 lllegal general instruction
» lllegal slot instruction

« NMI

(2) When an exception occurs on the CPU board while the user program is not being executed, the
HDI will display the EXPEVT code that corresponds to the cause of the exception, and the
monitor program will enter the reset-input wait state. In this case, turn the power to the CPU
board off and on, or input a reset, and start the HDI to initiate link-up processing.
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ge received from monitor

Exception occured EXPEWT = Ox00000040
Pleage rezet the CPL board !

Figure 6.1 Error Message Displayed at Exception (Instruction TLB Miss Exception)

4. Breakpoints

(1) Breakpoints cannot be set in a delay slot of a user program. If an attempt is made to set such a
breakpoint, the following message appears.

HDI B

& Canhot et a breakpaint at the specified address.

Figure 6.2 Dialog Box Indicating Breakpoint Cannot Be Set

For the above reason, a breakpoint may not be set if the initial data in the RAM is invalid when
a user program is loaded by specifying a session file. In this case, reload the program by
respecifying the session file.

(2) If a breakpoint is set within an interrupt or exception handler of a user program, it will not
cause a break.

(3) During single-step execution, the settings of the breakpoints are ignored.

(4) After 255 breakpoints (the maximum number) have been specified, if Add/Edit Breakpoint is
selected in the Breakpoints window, an error will occur. In this case, delete any unnecessary
breakpoints, and then add or edit breakpoints.

(5) After setting breakpoints, the CPU board must not be manual reset while the user program is
being executed. Otherwise, addresses where breakpoints have been specified will be
overwritten with illegal instructions.

To continue debugging the user program, download the user program again.

(6) A total of 255 breakpoints (including temporary breakpoints) can be set. A temporary
breakpoint cannot be set to the same address as an enabled breakpoint.

If a temporary breakpoint is set to the same address as a disabled breakpoint, the breakpoint
will be deleted from the breakpoints list after program execution have been completed.

(7) When the contents of a breakpoint address are modified during user program execution, the
breakpoint is disabled. In this case, if user program execution stops by any reason, the modified
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contents of the breakpoint address is lost and is replaced with the original contents before user
program execution.

(8) When a breakpoint is set, the block of the data cache that includes the breakpoint address is
made invalid when the user program execution starts and after a break occurs.

(9) When a breakpoint is set, all the entries of the instruction cache is made invalid immediately
before user program execution starts and after a break occurs.

. When a power-on reset or manual reset is input, the dialog box shown in figure. 6.3 and figure. 6.4
respectively is shown.

At this time, general-purpose registers and control registers are not reset. Either settings should be
changed as necessary, or the HDI should be restarted. And the run time count function availability
also be reset, so must be enabled again by the Run Time Count Condition dialog box if necessary.

ed from monitor

Power on reset iz detected.

Figure 6.3 Power-on Reset Input Message Box

ed from monitor

Marual rezet iz detected.

Figure 6.4 Manual Reset Input Message Box

If the power is turned on while pressing and holding the manual reset switch, the CPU board and
HDI will not be started. When turning on power, do not operate the manual reset switch.

In some cases I/O register values may not be correctly displayed in the memory window. This is
because the HDI reads all areas in byte units. In order to display the correct I/O register values,
select [I/O Register Window] from the [View] menu.

. The monitor program sets and uses some of the BSC registers. When rewriting these registers, refer
to section 5.9.3, Initial Settings of CPU Bus State Controller (BSC).

1/0 Ports
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Some of the port terminals on this board are also used as pins for other functions, and so some pins
cannot be used for port functions. The pin functions that can be used are included as signal names
in the pin names of the expansion connector pin assignments in table 5.10 in section 5.4, External
Interface. If signal name functions not included in the pin name are used, correct operation is not
guaranteed.

10. CPU Operating Mode

The operating mode of this CPU is set at a clock mode 5 and area 0 bus width of 32 bits. For other
CPU operating mode setting, only jumper J46 (corresponding to the MD5 signal) can be used to
modify the endian.

11. User Expansion Board Interface (User Expansion Area)
(1) Areas available for use with the expansion bus

The expansion bus can use areas 2, 4, 5, and 6, and cannot use area 0, 1, or 3. Monitor flash
memory is connected to area 0, on-board I/O is connected to area 1, and SDRAM is connected
to area 3.

(2) Devices which cannot be connected to the expansion bus

DRAM cannot be connected to the expansion bus. (This is because SDRAM on the CPU board
is allocated to area 3.)

(3) Interrupts

The NMI and external interrupts should all be processed by interrupt handlers in the user
program. For details refer to section 7, Creation of User Interrupt Handlers.

12. Refresh Timer
The refresh timer is used as an SDRAM refresh timer, and so cannot be used as an interval timer.

13. SCIF and Host Interface

(1) The serial interface with the host uses the SCIF in the CPU. For this reason, the user cannot use
the CPU’s internal SCIF except for the standard 1/0 processing using the [Simulated 1/0
Window]. For details, refer to section 7.2, User Program Using SCIF. Use SCI instead for a
purpose other than standard I/O processing. If the SCIF interface register is accidentally
overwritten, the CPU board and HDI will become inoperable.

(2) If the interface is disconnected while a program is being down loaded through the serial
interface, the HDI will stop abnormally. In this case, connect the serial interface cable
correctly, and start up the CPU board and HDI.

(3) This HDI does not support Motorola S-type files with only the CR code (H'0OD) at the end of
each record. Load Motorola S-type files with the CR and LF codes (H'ODOA) at the end of each
record.

(4) The CPU board and the HDI do not limit the address range for downloading a program. Be sure
to download programs to RAM areas. Otherwise operation cannot be guaranteed.

(5) When a Motorola S-type file is down-loaded, two menus, Load Program and Load Memory,
can be used, but the Load Program is recommended because it can transfer data faster.
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14. Compact PCI Interface

This CPU board is not provided with a PCI driver. When using the compact PCI interface, please
provide your own PCI driver.

15. E10A Emulator Interface

If the monitor is used with the E10A emulator connected, correct operation is not guaranteed.
Moreover, with the E10A emulator connected the port functions of the Hitachi-UDI and AUD
interface signal pins cannot be used.

16. Host Interface Software (HDI)

(1) In this HDI, the [Command Line] menu can be selected, but operation of the command entered
from the command line cannot be guaranteed. Do not use the command line.

(2) When using this CPU board, always use the included Hitachi Debugging Interface (HDI). If
other host interface software is used, the operation of the CPU board and of user programs is
not guaranteed.

(3) User can set default radix value with [Radix] menu from [Setup], but this setting doesn’t take
effect at line-assemble operation. All input values are assumed as decimal value. Specify H’ or
0x as the radix for a hexadecimal input.

(4) This HDI does not support software breakpoint setting in the [Select Function] dialog box
(described in section 10, Selecting Functions, in the Hitachi Debugging Interface User's
Manual).

(5) If the following memory contents are displayed in the [Memory] window, they should be
incorrect.

»  Word access from address 2n + 1

e Longword access from address 4n + 1, 4n + 2, or 4n + 3

The font size used in the memory window must be 4 or larger. In one window, up to 32768
bytes can be displayed.

(6) For each Watchdog Timer register, there are two registers, to be used separately, for write and
read.

Table 6.1 Watchdog Timer Register

Register Name Usage Register

WTCSR(W) Write Watchdog timer control/status register
WTCNT(W) Write Watchdog timer counter

WTCSR(R) Read Watchdog timer control/status register
WTCNT(R) Read Watchdog timer counter

(7) Since the CPU board cannot use another HDI, re-install this HDI whenever another previously
installed HDI is used.
If another HDI has been used, initiate this HDI with “Run” as follows, without using the
session files.
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<Directory path name in which HDI is installed>\hdi /n (RET)
/n initiates the HDI without loading the recently used session files.
If there is another session file on a different debug platform, the following error message is
displayed:

invalid target system: <recently used debug platform name>

(8) When another HDI is uninstalled after installation of this HDI, some functions may not work
correctly. In this case, re-install this HDI.

(9) For commands such as [Fill Memory] and [Test Memory], it may take a few minutes to
complete command execution. This depends on the size of data specified. Since only 5 seconds
is specified for the timeout time in the HDI of the CPU board, the [Command not ready] error
may occur. In such cases, the results of the command execution will not be guaranteed;
therefore, specify a smaller size and execute the command again.

(10) The access size and target start and end addresses can be specified in the [Fill Memory]
dialog box. If the access size does not match the specified start address, the HDI will treat them
as follows:

» Fill size = end address - start address
» The fill size is decreased to the nearest integer multiple of the access size.
» The start address is decreased to the nearest integer multiple of the access size.

« If the fill size is smaller than the access size, the fill size is increased to the nearest integer
multiple of the access size.

After the above processing, the HDI performs the memory-fill operation.

17. Watch

(1) Local variables at optimization
Depending on the generated object code, local variables in a C source file that is compiled with
the optimization option enabled will not be displayed correctly. Check the generated object
code by displaying the Disassembly window.
If the allocation area of the specified local variable does not exist, the following is displayed.

Example: The variable name is asc.
asc = ? - target error 2010 (Xxxx)

(2) Variable name specification
When a name other than a variable name, such as a symbol name or function name, is
specified, no data is displayed.

Example: The function name is main.
main =
(3) Array display
When the number of array elements exceeds 1000, the number exceeding 1000 will not be
displayed.

18. Run Time Count Function
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(1) The CPU board uses channel 4 of the internal timer of the SH7751 to implement run time count
functions. So, the user program cannot use channel 4 of the timer.

(2) The run time count function is only valid when user program execution has been started by
selecting Go from the Run menu. The run time is not measured during single-step execution.

(3) The overhead due to run time measurement is abqua @8r execution. For example, the
execution time of one NOP instruction measured is abous10

19. The values displayed as Cache Status and MMU Status in the Status window are the values for the
last break that occurred during user program execution. Values as updated in the 1/0O Registers
window are not displayed in the Status window.

6.2 Troubleshooting

1. On starting the HDI, the "Link up" message does not appear.
Check the following:
0 The power-on monitor LED (LED22) on the CPU board should be lit.
O The host computer and CPU board should be properly connected by a serial cable.
0 The port settings and transfer rate in the [Monitor Setup] dialog box should be correct.
0 The CPU board jumper settings should be correct.

2. “lllegal general instruction” appears on the HDI status bar, and program execution is halted.

This is displayed when a general exception occurs. This message appears when the EXPEVT
register value is H'180. It is caused by use of a privileged instruction in user mode, by use of an
undefined instruction, or for similar reasons. For further information refer to the SH7751 Hardware
Manual.

When a privileged instruction has been used in user mode, please take the following steps.
O In the register window, change the SR (status register) MD bit to 1 (privileged mode).

O Or, execute the [Reset CPU] command on the [Run] menu, and set the register values to the
following initial values.

Table 6.2  Register Initial Value Settings

Register Initial Value Description

PC H'’AC000000 User program area start address

SR H’600000EO Privileged mode, mask level 14

R15 (SP) H’AFF80000 Final address of user program area
VBR H’A0080000 (big endian) Monitor VBR (different from actual chip)

H’A0100000 (little endian)

3. Step command execution is slow.
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When the watch window and 1/O register window are open, the data in these windows must be
rewritten each time a step is executed, and so execution speed will be reduced. Decrease the sizes
of these windows to speed execution.
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Section 7 Creation of User Interrupt Handlers

7.1 Creation of User Interrupt Handlers

Cases where exceptions and interrupts are not used in the user program (no user interrupt
handlers are created):

Set the value of VBR to the initial value (big-endian: H’A0080000, little-endian: H’A0100000). By
doing so, step execution, breaks, and other debugging functions can be used when an exception or
interrupt occurs.

Cases where exceptions and interrupts are used in the user program (user interrupt handlers are
created):

Set the value of VBR to the start address of the user interrupt handler. By doing so, execution will
branch to the user interrupt handler when an exception or interrupt occurs. Add a routine to branch to
the following addresses to the user interrupt handler; this will enable step execution, breaks and other
debugging functions when an exception or interrupt occurs.

Table 7.1 lists the branch addresses for different interrupt causes.

Table 7.1  Interrupt Causes and Branch Addresses for User Interrupt Handlers

Branch Address Branch Address

Interrupt Cause Code (Big-Endian) (Little-Endian)
UBC trap EXPEVT=1EQ H’A0082000 H'’A0102000
Unconditional trap (FF) EXPEVT=160 H'’A0082020 H'A0102020
Reserved instruction code EXPEVT=180 H’A0082040 H’A0102040
exception

Slot illegal instruction EXPEVT=1A0 H’A0082060 H'A0102060
exception

CPU address error (load) EXPEVT=0EQ H’A0082080 H'A0102080
CPU address error (store) EXPEVT=100 H’A0082080 H’A0102080
NMI INTEVT=1CO H'A00820CO0 H'A01020CO0
SCIF-RXI* INTEVT=720 H'A00820E0 H'A01020E0

Note: When the SCIF is not used, a program to branch to the SCI-RXI destination address must be

prepared.
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Attention should be paid to the following when creating an interrupt handler.

1.

When branching to a branch address from the user interrupt handler, the values of RO and R1
(BANK1) must be saved on the stack.

In other words, @(R15-8) =R1 at time of exception (BANK1)
@(R15-4) = RO at time of exception (BANK1)
The following is an example of code which achieves this.
MOV.L RO, @-R15; save RO_BANK1
MOV.L R1, @-R15; save R1_BANK1

By this means, register values can be displayed during debugging when an exception or interrupt
occurs.

The values of control registers and general-purpose registers other than RO and R1 should be saved
at the time of occurrence of an exception or interrupt.

The BL bit of the SR register should be kept as 1 from the occurrence of an exception until
branching to the branch address.

The values of the SSR, SPC, EXPEVT, INTEVT, and TRA registers should be saved at the time of
occurrence of an exception.

Branching from a user interrupt handler should be performed with the RB and MD bits of the SR
register both set to 1 (the state of occurrence of an exception or interrupt).
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7.2 User Program Using SCIF

The user program cannot usually access the serial communication interface with FIFO (SCIF) in the
SH7751 because the CPU board uses it to communicate with the host PC. The CPU board provides the
[Simulated 1/0 Window] window to allow the user to use the SCIF.

When the SCIF is used from the user program, the SCIF driver in the user program communicates with
the [Simulated 1/0 Window] window on the host PC rather than with the actual SCIF directly. As
processing for interrupts of the CPU must be added to the user program, a user interrupt handler must
be created according to the directions in section 7.1, Creation of User Interrupt Handlers.

The HDI installer CD-R supplied with the CPU board contains a sample program for the user interrupt
handler and SCIF driver. For details on the sample program, refer to section 7.3, Sample Program.
7.2.1 Creation of SCIF Driver

Note the following when creating the SCIF driver.

» To receive serial data, an interrupt must be used. Create a SCIF-RXI (receive data full interrupt
request) processing routine.

* When the [HALT] button is pressed during serial receiving operation, the HDI sends the HALT
code (H'12) to the CPU board. When the HALT code is received, execution must branch to the
HALT break processing address in the CPU board.

Table 7.2 HALT Break Destination Address

Endian HALT Break Destination Address
Big endian H'A00820E0
Little endian H'A01020E0

» The branch to the HALT break processing is performed in the same interface as the branch to user
interrupt handlers. For details, refer to section 7.1, Creation of User Interrupt Handlers.

Notes: 1. The SCIF is used for communication between the CPU board and the host computer. If the
user uses the SCIF for a purpose other than the communication with the [Simulated 1/0
Window] window, correct operation cannot be guaranteed. For such purposes, use the SCI.

2. If processing that branches execution to the HALT break when the HALT code is received
is not prepared, the program cannot be stopped by clicking the [HALT] button in the HDI.

7.2.2 SCIF-Related Register Settings

The initial values of the SCIF-related registers are shown below. The shaded bits must not be
modified.

Serial Communication Interface with FIFO (SCIF):
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SCSMR2 (H'FFE80000) = H'0000

Bit

Initial
value

SCFCR2 (H'FFE80018) = H'0008

Initial
value

SCSCR2 (H'FFE80008) = H'0033

Bit

Initial
value

No restrictions are placed on accesses to the SCBRR2, SCFTDR2, SCFSR2, SCFRDR2, SCFDRZ2,
SCSPTR2, and SCLSR2.
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Interrupt Controller (INTC):

For the interrupts used by the user program, any interrupt level from 0 to 14 can be set, but interrupt
level 15 must not be used except for the SCIF.

IPRA (H'FFD00004) = H'0000

Bit 15 |14 |13 |12 |11 |10 |9 8 7 6 |5 4 3 2 1 0

TMUO TMU1 TMU2 RTC

Initial | O 0 0 0 0 0 0 0 0 0|0 0 0 0 0 0
value

IPRB (H'FFD00008) = H'0000

Bit 15 |14 |13 |12 |11 |10 |9 8 7 6 |5 4 3 2 1 |0

WDT REF SCI — | — | — | —

Initial | O 0 0 0 0 0 0 0 0 0|0 0 0 0 0 0
value

IPRC (H'FFD0000C) = H'00FO0

Bit 15 |14 |13 |12 |11 |10 |9 8 7 6 |5 4 3 2 1 0

GPIO DMAC SCIF H-UDI

Initial | O 0 0 0 0 0 0 0 1 1 1 1 0 0 0 0
value

IPRD (H'FFD00010) = H'0000

Bit 15 |14 |13 |12 |11 |10 |9 8 7 6 |5 4 3 2 1 0

IRLO IRL1 IRL2 IRL3

Initial | O 0 0 0 0 0 0 0 0 0|0 0 0 0 0 0
value

ICR (H'FFD00000) = Undefined

Bit 15 |14 |13 |12 |11 |10 |9 8 7 6 |5 4 |3 2 1 |0

NM NM | NM | IRL
IL IB |IE |M

Initial | 0/1 | O 0 0 0 0 0 0 0 0 |0 0 0 0 0 0
value

No restrictions are placed on accesses to the INTPRIOO, INTREQOO, INTMSKO00, and
INTMSKCLROO.
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7.3 Sample Program

This section describes how to create user interrupt handlers and the SCIF driver by using sample
programs.

The sample program files were created in C language and in SH-series assembly language by the work
space of the HEW. This program performs echo-back of the characters input from the [Simulated 1/O
Window] window, line by line, by using the SCIF. The sample program files, including source and
object files, are automatically copied to the Sample directory under the HDI installation directory.

Load the compiled load module (Simio.abs), set the program counter and stack pointer values (PC =
H'0C000000, R15 = H'AFF80000), and click the [Go] button to execute the program.

W Simulated IAD Window

Test Start.

> BECDEFGHIJKLMM. . .
ABCOEFGHIJKLMN. . .

> 12345
12345

>><>d

Figure 7.1 Executing the Sample Program

Note: The HEW work space supplied by this sample program was created by HEW Version 1.1a
(Release 3). The program cannot be opened by a HEW version earlier than 1.1a. For details,
refer to the Hitachi Embedded Workshop User's Manual.
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File Configuration:
Table 7.3 shows the files that compose the sample program.

Table 7.3  Sample Program Files

File Name Description

(install directory)\Sample\Simio.hws HEW work space file

(install directory)\Sample\Simio.hww HEW HWW file

(install directory)\Sample\Simio\Brkaddr.inc Branch address definition
(install directory)\Sample\Simio\Env.inc EXPEVT/INTEVT register definition
(install directory)\Sample\Simio\Intprg.src Interrupt processing program
(install directory)\Sample\Simio\lodefine.h SH7751 register definition
(install directory)\Sample\Simio\lolevel.c SCIF driver program

(install directory)\Sample\Simio\Main.c Main program

(install directory)\Sample\Simio\Resetprg.src Start program

(install directory)\Sample\Simio\Serial.h SCIF relation definition
(install directory)\Sample\Simio\Stacksct.src Global variable/stack area
(install directory)\Sample\Simio\Vect.inc Vector definition

(install directory)\Sample\Simio\Vecttbl.src Vector table area

(install directory)\Sample\Simio\Vhandler.src Interrupt handler

(install directory)\Sample\Simio\Simio.hwp HEW HWP file

(install directory)\Sample\Simio\Syntax.txt Syntax text

(install directory)\Sample\Simio\Big\Simio.abs ABS file for big endian
(install directory)\Sample\Simio\Little\Simio.abs ABS file for little endian
(install directory)\Sample\Simio\Make\Big.mak Make file for big endian

(install directory)\Sample\Simio\Makel\Little.mak Make file for little endian

Sections:
Table 7.4 shows the sections for the sample program.

Table 7.4  Sections for the Sample Program

Address Section Name
H'0C000000 - Start, IntPRG, P, and C
H'0CF7F000 - Dataarea

H'OCF7FCO00 - H'OCF7FFFF Stack

H'AC010000 - INTHandler and INTTBL
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Interrupt Handlers:

The interrupt sources and their processing are shown in table 7.5. If an interrupt that is not listed in
table 7.5 occurs, a sleep instruction will be executed.

Table 7.5 Interrupt Processing in the Sample Program

Interrupt Source Code Processing

UBC trap EXPEVT = 1E0 Branches to the CPU board. This
processing is used by Step execution.

Unconditional trap (FF) EXPEVT =160 Branches to the CPU board. This
processing is used by breakpoint function.

Reserved instruction code EXPEVT = 180 Branches to the CPU board and informs the

exception occurrence of a reserved instruction code
exception.

Slot illegal instruction exception  EXPEVT = 1A0 Branches to the CPU board and informs the
occurrence of a slot illegal instruction
exception.

CPU address error (load) EXPEVT = 0EO Branches to the CPU board and informs the
occurrence of a CPU address error
exception.

CPU address error (store) EXPEVT =100 Branches to the CPU board and informs the
occurrence of a CPU address error
exception.

NMI INTEVT = 1CO Branches to the CPU board. This
processing is used when execution is
stopped by using the abort switch.

SCIF-RXI INTEVT =720 Buffers the characters received through the
SCIF.
When the HALT code (H'12) is received,
execution branches to the CPU board. This
processing is used when execution is
stopped by the [HALT] button.
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